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Chapter 1 Introduction

PC Programming, referred to as PCPro, is an application used to manage the 
SV8100 system.  PCPro is rich with features to help users more easily manage a 
chassis when compared to handset programming.

The user can perform the following when using PCPro:

 Upload/Download settings between PCPro and a chassis.

 Save settings to files that can be archived for later use. 

 Program settings grouped by their relationship via standard screens. 

 Program settings sequentially via Wizards to complete a feature. 

 Generate reports that can be used to monitor settings.

 Automatically update chassis firmware remotely.

 Export settings to files for later use.

 Capture low level messages to problem solve through the Debug Terminal.
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Chapter 2 Installation

SECTION 1 SYSTEM REQUIREMENTS

The process of installing PCPro is straight-forward. Just run the installation program 
and follow the instructions. Table 2-1 System Requirements lists the minimum system 
requirements necessary for install PCPro on your computer.       

Table 2-1  System Requirements

CPU
Pentium® III 598 MHz (minimum)

Pentium 4 2.5 GHz (recommended)

Memory
128 MB of RAM

256 MB (recommended)

OS Microsoft Windows® 2000, Windows XP, Vista, Windows 7 (32/
64bit)

Other Microsoft Internet Explorer 6.0

Communication port LAN, RS232 or Modem

Disk Space 25MB for PCPro (minimum)

TCP Port

PCPro must have TCP port 8000 open between the chassis and 
the host PC. Communications between PCPro and the chassis 
occurs on this port when uploading / downloading via LAN.

The PCPro TCP port is 8000 at default, but this can be changed 
through the Administration>WebPro Settings section of WebPro 
using PRG 90-38-02.  PRG 90-38-02 is not accessible from 
telephone programming or PCPro.

TCP port 5963 is required to be open if the Debug Terminal is 
going to be used.
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SECTION 2 DEFAULT PCPRO ACCOUNTS

When installing PCPro for the first time, the installation program creates a set of 
default PCPro accounts. The accounts with the user name and password to access 
these accounts are provided in Table 2-2 Default PCPro Accounts.   

An install/uninstall does not remove or modify any existing PCPro Accounts, or 
Connection Accounts.

In addition, the installation program will create the following default folders:  

An install/uninstall does not result in the folder or any files in the folder being 
deleted.

Table 2-2  Default PCPro Accounts

User Name Password Access Level

necii 47544 Manufacturer Mode (MF)

tech 12345678 Installer Mode (IN)

ADMIN1 0000 System Administrator Mode 1 (SA)

ADMIN2 9999 System Administrator Mode 2 (SB)

Table 2-3  Default Folders

Folder Name/Icon Location Description

My Databases <install dir>\databases
Default folder where PCPro databases 
are saved.

DebugTerm <install dir>\logfiles
Default folder where PCPro Debug 
Terminal log files are saved.

Reports <install dir>\reports
Default folder where PCPro reports are 
saved.

exports <install dir>\exports
Default folder where PCPro exported 
files are saved.
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SECTION 3 SOFTWARE INSTALLATION

The software can be installed from the application CD, provided with the chassis or 
downloaded from the web. 

1. Launch the installer.

If installing from a CD, the CD should autorun.  When the splash screen is 
displayed, select Install Software.

 If the software does not autorun, you can open the CD and select setup.exe.

If downloading from the website, copy the file to your computer and launch the 
installer.

2. When the installer launches, the InstallShield Wizard Welcome screen is 
displayed.  Press Next>.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.

Figure 2-1  InstallShield Wizard Welcome Screen

X.XX.XX
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3. The next screen is displayed indicating the default location where the files 
reside on your computer.  

If the default location is where you want the files located, click Next>.  Refer to 
Figure 2-2 InstallShield Wizard Destination Folder (Default Location).

If you want to change the location where the files are located, click Change.  
Refer to Figure 2-3 InstallShield Wizard Destination Folder (Change Location).

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.

Figure 2-2  InstallShield Wizard Destination Folder (Default Location)



UNIVERGE SV8100 Issue 5.0

PC Programming Manual 2 - 5

___________________________________________________________________________________

___________________________________________________________________________________

 

Figure 2-3  InstallShield Wizard Destination Folder (Change Location)
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4. To install the program, click Install.

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.

Figure 2-4  InstallShield Wizard Begin Installation
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5. The program installs.  Figure 2-5 InstallShield Wizard Installation Progress 
shows the screen you will see that indicates the progress of the installation.  

If you wish to return to the previous screen, click <Back.

If you do not want to continue, click Cancel to abort the installation and exit the 
software.

Figure 2-5  InstallShield Wizard Installation Progress
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6. When the installation is completed, Figure 2-6 InstallShield Wizard Finish 
Installation is displayed.  Click Finish. 

Figure 2-6  InstallShield Wizard Finish Installation
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SECTION 4 LAUNCHING THE APPLICATION SOFTWARE

Once the application software has successfully installed you can launch the 
application in one of two ways:

 Click the PCPro shortcut icon that was placed on your desktop during installation.  

   or....

 Select the program by clicking Start > All Programs > NEC > SV8100 PCPro > 
SV8100 PCPro.  

Figure 2-7  SV8100 PCPro Desktop Shortcut

Figure 2-8  InstallShield Wizard Launch Software
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SECTION 5 LOGGING INTO THE APPLICATION

After you have launched the application, you must login using the User Name and 
Password.  Refer to Table 2-2 Default PCPro Accounts on page 2-2 for a list of default 
PCPro accounts and their associated user names and passwords. 

1. Enter the appropriate User Name and Password and press OK.

If you do not want to continue, click Cancel to abort login and exit the software. 

Figure 2-9  PCPro Login Screen
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2. If the login is successful, the PCPro Welcome screen is displayed.  

Figure 2-10  PCPro Main Menu
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Chapter 3 Application Layout

SECTION 1 INTRODUCTION

The programming section of PCPro provides methods to view and edit values 
associated with a chassis configuration.  Most programming is done using three 
different views: Standard, Wizard and System Data. These methods can be accessed 
through the menu item Programming.  Accessing these items updates the 
applications Submenu and Workspace areas. The Status bar gives a status indication 
of various functions related to PCPro (e.g., connection status, version information).

The general PCPro application layout is shown in Figure 3-1 PCPro Application 
Layout.

Figure 3-1  PCPro Application Layout

Menu

Toolbar

Submenu Status Bar
Workspace
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SECTION 2 MENU

The menu displays the list of functions available in PCPro. Some of these commands 
have images next to them so you can quickly associate the command with the image. 
The full list of the PCPro menu hierarchy is found in Chapter 7 - Menu and Toolbar 
Reference.

SECTION 3 TOOLBAR

The Toolbar is a group of buttons that map to items in the application menu. The 
toolbar allows for quick and convenient access to the most common PCPro 
commands. The items on the toolbar are shown in Figure 3-2 PCPro Toolbar. 

The keyboard shortcuts (where applicable) are listed below the toolbar 
identification in Figure 3-2 PCPro Toolbar.

  

The full list of the PCPro menu and toolbar hierarchy is found in Chapter 7 - Menu and 
Toolbar Reference.

SECTION 4 SUBMENU AREA

The Submenu Area is used to navigate through Standard View (refer to Chapter 4 - 
Standard View), Wizards (refer to Chapter 5 - Wizards View) and System Data (refer 
to  Chapter 6 - System Data View).  Selections made from the submenu area updates 
the workspace with the related settings.

Figure 3-2  PCPro Toolbar
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SECTION 5 WORKSPACE

The Workspace is where all programming occurs. The Workspace consists of various 
selections made from the Submenu Area and the Workspace itself. Common 
Workspace components are further explained.  

Figure 3-3  PCPro Workspace

Title Subtitle

Workspace 
Buttons

Data Area

Navigation Area

Help Area
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5.1 Title

Title describes what the current settings in the Workspace are related to. This 
is associated with the selection made in the Submenu Area. The title is 
situated at the top left corner of the Workspace.

5.2 Subtitle

Subtitle shows further information about what the you are programming.

5.3 Workspace Buttons

The Workspace buttons area displays different buttons relevant to current 
programming. These buttons include:   

Table 3-1  Workspace Buttons

Button Description

Apply sets changes recently made on the active screen. Attempting to 
apply an invalid value prompts a validation message detailing the 
error.  In this case, changes are not applied until the value is made 
valid.

Back returns to the previous screen for the specified feature.  This 
button is only available when using Wizards.  

Cancel discards recent changes made to the active screen that have 
not been applied and displays the Home screen in the Workspace.

Copy shows the Copy dialog.  Refer to Appendix C - Copy for more 
information.

Default resets the active screen to the system default values.

Finish indicates that this is the only program for this feature.  Once 
you have entered the information for the program, you are finished 
programming the feature.
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When you do not click the Apply button, but do one of the following, the 
system applies the changes as if you had clicked the Apply button.

 Attempt to leave the current screen.

 Attempt to navigate a different item within the system data.

 Use the Previous button.

 Use the Next button.

 Save the active configuration.

 Exit the application.  (Note that on some screens, the system prompts you 
to save the changes or to exit without saving them.)

 Generate a report.

Form View is available on screens that have a large number of values 
that must be entered (e.g., screens with telephone extensions).  When 
Form View is selected, the screen switches to a table format, allowing 
you to more easily enter a large number of values for a specified 
extension.  

For example, if assigning your incoming virtual ring tones for internal 
extensions, you can switch from Grid View to Form View to list all of  
the extensions in table format.  

Note that this option is not available on all screens.

Grid View is available on screens that have a large number of values 
that must be entered (e.g., screens with telephone extensions).  When 
Grid View is selected, the screen switches to the default view, which 
displays the values with pulldown boxes.   

For example, if assigning you incoming virtual ring tones for internal 
extensions, you can switch between Grid View to Form View. 

Note that this option is not available on all screens.

Next proceeds to the next screen for the feature.  When all of the 
programs have been displayed for the selected feature, pressing Next 
returns you to the Main screen.  This button is only available when 
using Wizards. 

Table 3-1  Workspace Buttons

Button Description



3 - 6 Application Layout

___________________________________________________________________________________

___________________________________________________________________________________Issue 5.0 UNIVERGE SV8100

5.4 Navigation Area

To navigate to different items within a program, use the various navigation 
buttons.  

 

Figure 3-4  PCPro Navigation Buttons

Table 3-2  Navigational Buttons and Drop Down List

Button/Menu Description

Selections Select the item from the drop down list. PCPro 
automatically moves to the selected item.

Ranges Use this button to select a range of values.  Type in the 
value and press the ‘Go’ button (magnifying glass icon) or 
press Enter.  PCPro displays a range of available items, 
beginning with the value you typed.  For example, if you 
typed Station Port 300, PCPro displays a range of ports 
beginning with port 300.

Previous/Next Use Previous to show settings of the preceding item.

Use Next to show settings of the next item.

Select an item to view

Move to the previous item

Move to the next item

Navigation Filters

Move to specified items
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5.5 Data Area

The Data Area is where actual system data appears. The contents of this area 
are specific to what the you are programming. For example, if programming 
PRG 10-02, this area shows all the data items within 10-02.

The contents of the Data Area are linked to the various system data views 
available. These are:

 Standard

 Wizards

 System Data

5.6 Help Area

The Help Area shows help text relevant for the data in the Data Area. More 
extensive help can usually be found in the application online help (F1 key).

5.7 Status Bar

The status bar, which is a horizontal area at the bottom of the Workspace, 
provides information about the current state of what you are viewing in the 
Workspace and any other contextual information.    

Figure 3-5  PCPro Status Bar

PCPro Account User 
Name And Access Level

Description
of Menu Area

Site Name and 
Connection Type

PCPro File 
Version

Chassis CPU 
Version

System Data 
Modification 

Indicator
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-- NOTES --



PC Programming Manual 4 - 1

___________________________________________________________________________________

Chapter 4 Standard View

SECTION 1 OVERVIEW

Standard View combines related settings into one screen, allowing a quick setup of a 
high level task. Settings on these screens work together, allowing you to understand 
how settings relate to each other. Standard screens are identified by their name. This 
name indicates the tasks with which the screen is related. 

Figure 4-1  Standard View Submenu

Window View: Clicking this 
icon displays the flyout, which 
allows you to select how you 
want the Standard submenu 
displayed.  Right mouse clicking
also displays this menu.

Auto Hide: Clicking this icon 
hides the Standard submenu 
list and docks the tabs on the 
left side of the screen.

Close: Clicking this icon 
closes the Standard submenu 
list and tabs. 
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SECTION 2 STANDARD VIEW SUBMENU

2.1 Accessing Standard View

You can access Standard View submenu area using any of the following 
methods: 

 From the Standard View submenu, select the menu item 
Programming > Standard.

    or…

 Select the toolbar icon depicting the purple cog .

    or…

 Press F9.

   or…

 If the submenu area is currently open, select the Standard tab depicting 
the purple cog icon.  

Once selected, the Standard View menu appears in the Programming 
submenu area. Standard screens are listed alphabetically.

To view a particular Standard View screen, click on the screen name.  

Figure 4-2  Selecting a Standard View Screen
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2.2 Using a Standard View Screen

Each Standard View screen works differently. However the following common 
methods apply:

1. Select the Standard View screen from the Standard View menu relevant 
to the desired task.

2. Modify settings on the screen.

3. Press the Apply button to save the changes.

The method in modifying settings for each screen is explained in the help 
menu.

The remainder of this chapter discusses the individual options available from 
the Standard View submenu.  

SECTION 3 CARD CONFIGURATION

The screen represents a conceptual model of the chassis and the blade packages 
within it. To obtain blade details download the configuration from the chassis. The 
blade slots display the blade types (these are the blades that can be inserted in the 
selected slot), the telephone/trunk port range (these are the ports used by the blade) 
and firmware version (firmware being used by the blade). By default, all blade slots 
displayed as white indicating no blade has been installed in that slot.  

On this screen, you can right mouse click on the desired slot.  A popup menu is 
displayed indicating the configurable options for that slot.  Once you have selected 
the blade that is installed in that slot, the blade name is displayed on the front of the 
slot location.  

Refer to Figure 4-3 Standard View Card (Blade) Configuration Screen on page 4-4 for 
the layout of the Card Configuration screen.
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3.1 Blade Types

In PCPro, blade types are categorized under the following four groups.  When 
you right click on the chassis model on the screen, the popup menu is 
displayed.  The menu lists the blades and each blade type is designated with 
a distinctive color.   

Figure 4-3  Standard View Card (Blade) Configuration Screen

Right mouse click to 
display the configurable 
options for the selected 
slot.

After the slot has  been 
configured with the 
blade, the blade name 
is displayed on the 
front on the chassis.

Until the slot is 
assigned, the blade is 
‘white’, indicating the 
slot is empty.

If IPK II MIgration is 
checked, it indicates 
the system is using IPK 
Migration.

This section shows the power factor for each 
chassis with blades (boards) and terminals 
installed.

Click the IP to ETIA button to attach IP phones to 
ensure they are counted toward the terminal power 
factor.

Blade Type and Color
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Telephone
Represented on the Blade Configuration screen as 'blue' blades. Telephone 
blades provide interfaces to telephones being used in the chassis. Telephone 
blades use telephone ports (e.g., a CD-8DLCA makes use of eight telephone 
ports).

Trunk
Represented on the Blade Configuration screen as 'yellow' blades. Trunk 
blades provide interfaces to lines such as COI, DID, OPX, BRI, PRI, T1, CCIS, 
etc., which are being used in the chassis. Trunk blades, use trunk ports (e.g.,  
a CD-4COTB blade makes use of four trunk ports).

Combo
Represented on the Blade Configuration screen as 'yellow/blue' blades. Trunk 
blades provide interfaces to lines such as digital single line stations, which are 
being used in the chassis. Combo blades, use telephone ports (e.g., a CD-
LTA blade makes use of eight digital telephone ports and two analog ports).

Other
Represented on the Blade Configuration screen as 'green' blades. These 
miscellaneous blades do not have a direct relationship to a trunk or telephone. 
However, some blades under this category (e.g., CD-VM00) use telephone 
ports as they are associated with extensions.

3.2 Adding a Blade

To add a blade, complete the following steps:

1. With the mouse, right click on the slot where you want the blade to 
reside.

2. A popup menu appears listing the blade types that can be installed.  

There are two additional options on the popup menu.  These are 
Configure Card and Delete Card.   Note that these two options 
are only available if a blade has previously been added.

3. Select a blade type relevant to the blade to install.

4. Another popup menu appears listing blades associated with the selected 
blade type.

5. Select the desired blade package you want to add.

The slot changes appearances indicating the blade installed, the firmware 
version being used, the port type, and the port range being used.
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3.3 Removing a Blade

To remove a blade, complete the following steps:

1. With the mouse, right click on the blade you want to remove.

2. When the popup menu is displayed, select Delete Card.  

The blade is removed and the slot and port type range it was utilizing is now 
available for use by another blade.

3.4  Assigning IP Phones to ETIA Blades

To assign an IP to an ETIA blade, complete the following steps:

1. Click on the IP to ETIA button.

2. Right click on the IP phone to assign it to the ETIA blade.

3. Select the ETIA blade to which the IP phone is connected.

 Selecting External Hub means the phone is not connected to an ETIA blade.

 Set the phone type using PRG 15-05-26 to ensure the correct power factor is 
assigned by the system.

4. Click OK to save your selection.

Figure 4-4  Connect IP Terminals to ETIA Blades
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SECTION 4 SYSTEM INSTALLATION

The System Installation screen allows you to assign initial settings for the SV8100 
system.    

To assign the initial system settings:

1. Select the Country (United States or Canada) and GMT Time (appropriate time 
zone) where the system installed.

2. Assign the IP Address, Subnet Mask, Default Gateway, Optimum Baudrate 
and SMDR Output as required for the installation site.

Figure 4-5  Standard View System Installation

1) Select Country 
and time zone.

2) Assign Connection 
Settings.

3) Assign Night Mode Switching.5)  Select if InMail is the voice mail used. 4)  Assign music source.

6)  Assign local area and 
preferred carrier codes.

7)  Assign extension 
numbers.
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3. Assign whether the system automatically switches to Night Mode.  If you select 
Automatic Night Mode Switching, you also need assign the time the system 
switches to day mode (Day Mode Switch Time) and to night mode (Night 
Mode Switch Time).

4. Use the pulldown menus to disable Music on Hold or Background Music, or 
assign the music source.

5. Select InMail if this is the voice mail that the system uses.

6. Assign the Local Area Code and Preferred Carrier Code.

7. Assign extension numbers for virtual, operator, Music on Hold ACI extension 
and Background Music ACI extensions.  Also assign the Voice Mail Pilot 
extension.  The Current Extension Plan for the assigned extensions is displayed 
(this field is view only).
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SECTION 5 TELEPHONE SETUP

This screen combines system data, which is relevant for telephone settings.  It allows 
you to assign basic telephone settings.    

Figure 4-6  Standard View Telephone Setup

Highlight the areas for multi-assignment and right 
mouse click to open the MultiAssign dialog box.

2~7)  Assign the appropriate 
telephone setup options.

1)  Select the ICM Extension 
to view.
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To assign the basic telephone settings.

1. Use the ICM Extension pulldown menu to select a specific extension you want 
to view.  The selected extension is highlighted.

2. Assign the Name (Extension Name) that is displayed.

3. Assign a Dep Grp (Department Group) to the selected telephone for incoming 
ringing priority.

4. Assign the Int Page Grp (Internal Paging Group) selected telephone to an 
internal paging group (e.g., to assign the telephone paging zones and to specify 
whether the telephone can receive internal all call paging).  

5. Assign Day-Toll Restr (Day Mode Toll Restriction) class for Day Mode.

6. Assign Night-Toll Restr (Night Mode Toll Restriction) for Night Mode.

7. Assign Hol-Toll Restr (Holiday Mode Toll Restriction) for Holiday Mode.

8. Use the pulldown menu to assign Off Hk Rng (Off-Hook Ringing) to the 
extension.

9. Enable/Disable Rng Ln Pref (Ringing Line Preference) for the extension. 

10. Enable/Disable Trk Ln Pref (Trunk Line Preference) for the extension.

11. Click Apply to save the settings.

MultiAssignment

Telephones the have the same properties can be assigned in a block by using the 
MultiAssign feature.

 The extension name cannot be multi-assigned.

To assign properties to a block of telephones:   

1. Select the area of cells to be assigned in a block. 

2. Right click the mouse within the selected area. The MultiAssign dialog box is 
displayed.  (Refer to Figure 4-6 Standard View Telephone Setup on page 4-9.)

The MultiAssign dialog is filled with the values from the top most selected lines. 
If any cells on that line are disabled, the default value for that item is used. 
Columns that are not selected are disabled.
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3. Make your selections and click OK.  All selected telephones are assigned the 
values in the MultiAssign dialog box.

Figure 4-7  Standard View Telephone Setup MultiAssign Dialog
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SECTION 6 CLASS OF SERVICE FOR TELEPHONES

This screen combines system data relevant to Class of Service Options for 
telephones. 

Figure 4-8  Standard View Class of Service for Telephones

1) Select Class of Service

2) Enable/Disable 
services for Class.

3) Select Night Mode.

4) Select telephones 
using this Class of 
Service Night Mode.
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The assign Class of Service settings for telephones:

1. Select the Class of Service (1~15) you want to assign to the telephones.

2. Enable/Disable telephone-specific service options for the selected Class of 
Service. These settings are linked with programs 20-07, 20-08, 20-09, 20-10, 
20-11, 20-12 and 20-13.

You can select one of three options for viewing the services:  
  Show all services.
      or....
  Show only enabled services.
      or....
  Show only disabled services.

You can also choose how you want to view the options:

  Categorized (by program)    

     or....

 Alphabetic (by feature name)

3. Select the Night Mode from the pulldown menu.

4. Click the telephones that you want to assign to the specified Night Mode.

The selected telephones will be members of the class during the selected Night 
Mode. These settings are linked with 20-06.

5. Click Apply to save the settings.
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SECTION 7 CLASS OF SERVICE FOR DISA/E&M TIE LINES

This screen combines system data relevant to Class of Service options for DISA 
users and E&M Tie Lines.   

To assign Class of Service options for DISA and E&M Tie Lines.

1. Select the Class of Service (1~15) you want to assign to the telephones.

2. Enable/Disable telephone-specific service options for the selected Class of 
Service. These settings are linked with programs 20-14.

Figure 4-9  Standard View Class of Service for DISA/E&M Tie Lines

1) Select Class of Service.

2) Enable/Disable 
services for Class.

3) Select Night Mode.

4) Select DISA users 
and Tie Lines using 
Class of Service for 
Night Mode.
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You can select one of three options for viewing the services:  
  Show all services.
      or....
  Show only enabled services.
      or....
  Show only disabled services.

You can also choose how you want to view the options:

  Categorized (by program)    

     or....

 Alphabetic (by feature name)

3. Select the Night Mode from the pulldown menu.

4. Click the DISA users and E&M Tie Lines that you want to assign to the specified 
Night Mode.

The selected DISA users and E&M Tie Lines will be members of the class 
during the selected Night Mode. DISA settings are linked with program 25-09 
and E&M Tie Line settings are linked with program 34-02.

5. Click Apply to save the settings.
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SECTION 8 DEPARTMENT GROUPS

This screen combines system data relevant to the feature Department Groups.   

To setup up a Department Group:  

1. Specify a Department Group to modify.

2. Specify basic characteristics (Basic Settings) of the Department Group.

The Basic Settings section basic characteristics of the selected Department 
Group. These settings are linked with 16-01.

Figure 4-10  Standard View Department Groups

1) Select Department 
Group.

3) Select Primary 
Members.

2) Set up basic 
characteristics of 
selected Department 
Group.

4) Set priority for 
Primary Members.

5) Select Secondary 
Members (max. 16).

6) Set priority for 
Secondary Members.
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3. Select the extensions that are Primary Members of the Department Group.

All extensions that are Primary Members of the selected Department Group are 
listed.  Every extension must belong to one of the 64 available Department 
Groups. By default, all extensions are Primary Members of Department Group 
1. By removing an extension from Department Group 1 it is automatically 
assigned to Department Group 64. These settings are linked with 16-02.

4. Specify the priority for the selected Primary Members.

When an extension is selected as a Primary Member it automatically appears in 
the priority list (the list to the bottom of the Primary Member list). The priority of 
the selected extension can be modified by the following key combinations:

 Shift + Up Arrow Increase priority by 1

 Shift + Down Arrow Decrease priority by 1

 Shift + Page Up Increase priority by one page

 Shift + Page Down Decrease priority by one page

 Shift + Home Make highest priority

 Shift + End Make lowest priority

5. Select the extensions (maximum of 16) that are Secondary Members of the 
Department Group.

All extensions that are Secondary Members of the selected Department Group 
are listed. A maximum of 16 extensions can be assigned as Secondary 
Members. These settings are linked with 16-03.

6. Specify the priority for the selected Secondary Members.

7. When an extension is selected as a Secondary Member it automatically appears 
in the priority list (the list to the bottom of the Secondary Member list). The 
priority of the selected extension can be modified by using the same key 
combinations as in the case of setting the priority for Primary Members.
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SECTION 9 DID TRANSLATION TABLE

This screen combines system data relevant to the DID Translation Table and Trunk 
Groups using DID. These settings are used with the feature “Direct Inward Dialing”. 

Figure 4-11  Standard View DID Translation Table

6) Set Trunk Group 
specific DID settings.

5) Select which Trunk 
Groups use the selected 
DID Table area.

1) Set up DID Table Area.  
Specify the entry range in 
the global translation table.  
Use the right mouse button 
to edit the ranges.

2) Set the entries for 
the selected area.

4) Set Intercept Ring 
Group for selected DID 
Table area.

3) Select Night Mode.
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To setup the DID Translation Table and associate it with Trunk Groups:

1. Select and define a Table Area within the DID Translation Table.

The DID Translation Table consists of 2000 entries that can be divided among 
20 Table Areas, each being made up of a 1st and 2nd Area. Using the mouse, 
right click a Table Area to define its 1st and 2nd entry ranges it uses. These 
settings are linked with 22-10.

When a Table Area is selected, the grid to the right is updated with the new 
entry range. For example, selecting Area 01, 1st Area (entry ranges 001~100) 
will result in the grid showing the DID Table entries 001 to 100.

2. Specify the selected Table Area entries and how they are treated with DID.

Table Area entries are located in the grid to the right of the Table Area list. It 
defines DID Table Area entries and how they are directed within the system. 
These settings are linked with 22-11.

3. Select the Night Mode to modify for DID.

Assign the Trunk Groups that use the Table Area via this Night Mode selection. 
In addition, use this to help define the Intercept Ring Group calls get forward to 
during Night Modes. Do this by completing the following:

 Select a Night Mode.

 Select the Trunk Groups during this Night Mode that will use the selected Table
Area.

 Define the Intercept Ring Group calls that are forwarded during this Night Mode.

Figure 4-12  Standard View DID Table Area Edit Popups

1)  Use the right mouse 
button to show the popup.

2)  Specify the entry ranges for 
1st and 2nd areas.
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4. Specify the Intercept Ring Group to use by the Table Area during the selected 
Night Mode.

Specifies if the call, during the selected Night Mode, is directed toward an 
Incoming Ring Group or voice mail. This setting only applies when the option is 
enabled in the associated DID Translation Table entry. This setting is linked with 
22-12.

5. Select the Trunk Groups that use the Table Area during the selected Night 
Mode.

This section lists the Trunk Groups that use the Table Area for DID during the 
selected Night Mode. These settings are linked with 22-13.

6. Specify the DID settings for the selected Trunk Group.

The basic setup details for the Trunk Group DID settings are selected in this 
section. These settings are linked with 22-09.
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SECTION 10 NIGHT MODE SWITCHING

This screen combines system data relevant to the Chassis feature “Night Service”.   

Figure 4-13  Standard View Night Mode Switching

1)  Enable/Disable 
Night Mode Service 
Code activation.

2)  Enable/Disable 
Night Mode Service.

3)  Select Service 
Group to modify.

5)  Specify Schedule 
Pattern applied to 
each day of week.

6)  Assign names to 
each mode.

4)  Set up the 
Schedule Patterns.

7)  Specify holidays 
in Service Group.

8)  Specify trunks that 
use this Service Code.

9)  Specify extensions that 
use this Service Group.



4 - 22 Standard View

___________________________________________________________________________________

___________________________________________________________________________________Issue 5.0 UNIVERGE SV8100

To setup the Night Mode Switching options:

1. Enable/disable users from activating Night Mode Service via a service code.

This selection enables/disables users from activating Night Mode Service via a 
service code. This setting is linked with 12-01-01.

This is a system-wide setting and is applied across ALL Service Groups.

2. Enable/disable Automatic Night Mode Service.

This selection enables/disables Night Mode Service for the system. This setting 
is linked with 12-01-01.

This is a system-wide setting and is applied across ALL Service Groups.

3. Specify a Night Mode Service Group (1~32) to modify.

4. Define Schedule Patterns used by the selected Night Mode Service Group. 
Schedule Patterns are comprised of time frames that are associated to Night 
Modes.

You can define up to 10 Schedule Patterns for the selected Night Mode Service 
Group. Schedule Patterns can be made up of 20 time frames. Each time frame 
is associated with a Night Mode. These settings are linked with 12-03.

Refer to 10.1 Adding a Time Frame on page 4-23, 10.2 Removing a Time Frame 
on page 4-24, 10.3 Moving a Time Frame on page 4-24 and 10.4 Modifying a 
Time Frame on page 4-25.

5. Specify the Service Patterns applied to each day of the week.

Define the Schedule Pattern used each day of the week by the selected Night 
Mode Service Group. These settings are linked with 12-03.

6. Assign a name to each Night Mode.

This can be used to identify the time frame. Night Mode names defined here are 
referred to throughout the system. These settings are linked to 12-07.

7. Define public holidays and the Schedule Pattern used by the Night Mode 
Service Group on these days.

These settings are linked with 12-04.

8. Select the trunks that are members of the Night Mode Service Group.

These settings are linked with 12-06.

9. Select the extensions that are members of the Night Mode Service Group.

These settings are linked with 12-05.
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10.1 Adding a Time Frame

This section describes how to add a time frame to a schedule for night mode 
switching. 

 To add a time frame in a Schedule:

1. Using the mouse on the Schedule Pattern bar, left click and drag from 
the starting time toward the end time. A colored bar appears defining this 
time frame. Keep the left mouse button pressed while dragging.

2. Release the left mouse button. A dialog then prompts for the Night Mode 
associated with this time frame.

3. Select a Night Mode associated with this time frame.

The colored bar changes its color depending on the Night Mode defined.

Each mode is assigned a different color. These colors are shown in 
Figure 4-15 Standard View Night Mode Switching Mode Colors on page 
4-24.

Figure 4-14  Standard View Night Mode Switching Adding Time Frame

Move the left mouse button 
over the slider area until an up/
down arrow is displayed,  While 
holding down the left mouse 
button, move the slider to the 
desired position and release the 
mouse button to set the time.  

Release the 
mouse button 
when finished.

The Mode Selection dialog box 
is displayed when the time 
frame has been selected.  
Select the desired mode from 
the pull down selection menu.

Popup 
indicating 

duration and 
Night Mode.
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10.2 Removing a Time Frame

To remove a time frame, select it then drag it either left or right off the 
Schedule Pattern bar. Alternatively, select the time frame and press the 
Delete key.

10.3 Moving a Time Frame

To move a time frame select it with the mouse and drag it to the desired 
position. Surrounding time frames can limit changes because time frames 
cannot overlap. To solve this problem either remove time frames or modify 
them.

Figure 4-15  Standard View Night Mode Switching Mode Colors

Mode 7

Mode 6

Mode 8

Mode 5

Mode 4

Mode 3

Mode 2

Mode 1
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10.4 Modifying a Time Frame

To modify a time frame in a Schedule Pattern:

1. Select the time frame to modify.

2. Place the cursor at the top/bottom of the time frame until it changes 
appearance. 

3. Left click then drag from the starting/ending time to the desired change.

Surrounding time frames can limit changes because time frames 
cannot overlap. To solve this problem either remove existing time 
frames or modify them.

10.5 Time Frame Duration

To find out the duration of a time frame select it and then hold down the left 
mouse button. A popup appears indicating the duration and Night Mode.

10.6 Time Frame Night Mode

To find out the Night Mode of a time frame select it and then hold down the left 
mouse button. A popup appears indicating the duration and Night Mode.
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SECTION 11 INCOMING RING GROUPS

This screen combines system data relevant to the feature “Incoming Ring Groups”.   

To setup up an Incoming Ring Group:

1. For each trunk, specify the Incoming Ring Group of which it will be a member.  
Alternatively, route the call from the trunk to a voice mail type. Individual settings 
can be applied to each Night Mode.

These settings are linked with 22-05.

2. Select the incoming Ring Group to which the trunks and extensions are 
assigned.  You can use the right and left arrows to select the previous or next 
Ring Group (1~100).

3. Select the extensions that are members of the Incoming Ring Group.

These settings are linked with 22-04.

Figure 4-16  Standard View Incoming Ring Groups

1)  Place each trunk 
in a Ring Group or set 
the trunk to terminate 
on voice mail instead 
of a Ring Group.

2)  Select the Ring 
Group.

3)  Select which 
extensions are in the 
Ring Group.
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SECTION 12 SYSTEM TIMER CLASSES

This screen allows you to set up system-wide timers.  

The settings that can be changed on this screen include the individual timers.

To change the timer settings from the default:

1. Click the value to the right of the time you want to change.

2. Change the timer setting and click Apply.

Figure 4-17  Standard View System Timers

1)  Make necessary 
changes to the timers.

2)  Click Apply.
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SECTION 13 SYSTEM TIMER CLASSES

This screen combines system data relevant to Timer Classes. Timer Classes detail 
sets of operation times. Trunks and extensions can be assigned as members of these 
classes for each of the system Night Modes.  

Figure 4-18  Standard View System Timer Classes

1)  Select Time Class.

2)  Set various Timers 
in the class.

4)  Specify which trunks use 
this timer class for the 
specified Night Mode.

3)  Select Night 
Mode.

5)  Specify which extensions 
use this timer class for the 
specified Night Mode.
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The settings that can be changed on this screen include:

 Time Class:  The Timer Class to which timers are assigned.

 Night Mode:  The Night Mode assigned for night mode switching.

 Timers:  The system wide timers that can be changed.

 Trunks/Telephone:  Lists the trunks/telephones that are members of the class 
during the selected Night Mode. 

 Extensions:  Lists the extensions that are members of the class during the 
selected Night Mode. 

To setup up a Timer Class complete the following:

1. Specify a Time Class (1~15) to modify.

2. Set the various timers for the specified Time Class.

These settings are linked with 20-31.  (All times are in expressed in seconds.)

3. Select a Night Mode.

4. Select the trunks/telephones that are members of the Time Class during the 
selected Night Mode.

These settings are linked with 20-30.

5. Select the telephone extension that will use members of the Time Class during 
the selected Night Mode.  A different Time Class can be set to each Night Mode.

These settings are linked with 20-29.
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SECTION 14 TRUNK ACCESS MAP

This screen combines system data relevant to the Trunk Access Map. The Trunk 
Access Map administers the usage of trunks by the extension. Extensions can be 
assigned to one of the 200 Access Maps for each of the system Night Modes. 

Figure 4-19  Standard View Trunk Access Map

1)  Select the Trunk 
Access Map.

2)  Select the Night 
Mode.

3)  Specify the type of access for each trunk.  Use the right mouse button 
to display the types of access.

4)  Select which extensions 
are in the Trunk Access 
Map for the specified Night 
Mode.
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To setup a Trunk Access Map complete the following: 

1. Specify a trunk Access Map (1~200) to modify.

2. Select a Night Mode.

3. Specify the access type for each trunk using the Trunk Access Map.

To modify the access type, right click the trunk then select an access type from 
the popup menu. These settings are linked with 14-07.

The various access types are listed below: 

4. Select the extensions that use the Trunk Access Map during the selected Night 
Mode.

These settings are linked with 15-06.

Access Type Image

No access

Outgoing access only

Incoming access only

Access only when trunk on hold

Outgoing access when trunk on hold

Incoming access when trunk on hold

Incoming/outgoing access

Incoming/outgoing access when trunk on hold
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SECTION 15 TRUNK GROUPS

This screen combines system data relevant to Trunk Groups.  Trunk Groups prioritize 
the use of a group of trunks.  Priority of Trunk Groups can be done via the Route 
Table.  A Route Table entry can then be used by trunks and extensions.   

Figure 4-20  Standard View Trunk Groups

1)  Select the Trunk 
Group.

2)  Add trunks to the 
Trunk Group.

3)  Assign priorities to 
the trunks in the 
Trunk Group.

4)  Set up the Route 
Table.

5)  Select the Route Table 
and the Night Mode.

6 & 7)  Specify the extensions that use 
the selected Route Table.

8)  Specify the trunks that use 
the selected Route Table.
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To setup a Trunk group complete the following: 

1. Specify a Trunk Group (1~100) entry to modify.

2. Select the trunks that are members of the Trunk Group.

These settings are linked with 14-05-01.

3. Prioritize trunks by ordering them in preference.

These settings are linked with 14-05-02.

When a trunk is selected as part of the Trunk Group it automatically appears in 
the priority list (the list to the bottom of the Trunk Group list). The priority of the 
selected trunk can be modified using the following key combinations:

 Shift + Up Arrow Increase priority by 1

 Shift + Down Arrow Decrease priority by 1

 Shift + Page Up Increase priority by one page

 Shift + Page Down Decrease priority by one page

 Shift + Home Make highest priority

 Shift + End Make lowest priority

4. To setup a Route Table entry:

This entry defines four destinations where the Route Table entry directs calls. 
Calls can terminate on a Trunk Group or flow on to another entry in the Route 
Table. 

Destinations are prioritized 1~4 with 1 being the highest and 4 being the lowest. 
These settings are linked with 14-06.

5. To assign the extensions and trunks that use the Route Table Entry, select a 
Route Table (1~100) and a Night Mode.

6. Select the extensions that use the Route Table entry during the selected Night 
Mode.

This applies to extensions using the Trunk Service Code to access trunks. 
These settings are linked with 21-02.

7. Select the extensions, during this Night Mode, that use the Route Table entry 
via the alternate Trunk Access Code.

This applies to extensions using the alternate Trunk Service Code to access 
trunks. These settings are linked with 21-15.

8. Select the trunks, during this Night Mode, that use the Route Table entry.

These settings are linked with 21-03.
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Chapter 5 Wizards View

SECTION 1 OVERVIEW

Wizards chronologically group System Data, guiding users in the successful setup of 
a  feature. Wizards are identified by their name. This name indicates the feature to 
which the Wizard is related.

Wizard System Data is grouped by screens. Complete each screen in a Wizard to 
complete a feature.   

Figure 5-1  Wizard Submenu

Window View: Clicking this 
icon displays the flyout, which 
allows you to select how you 
want the Wizard submenu 
displayed.  Right mouse clicking 
also displays this menu.

Auto Hide: Clicking this icon 
hides the Wizard submenu list 
and docks the tabs on the left 
side of the screen.

Close: Clicking this icon 
closes the Wizard submenu 
list and tabs. 
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SECTION 2 ACCESSING WIZARD VIEW

To access Wizard View complete one of the following:

 Select the menu item Programming > Wizards.

    or…

 Select the toolbar icon depicting the wand .

    or…

 Press F10.

or…

 If the Wizard submenu area is currently open, select the Wizard tab depicting 
the magic wand, located at the bottom on the submenu.  

The Wizard View Menu appears in the submenu area. Wizards are ordered 
alphabetically.   Refer to Figure 5-1 Wizard Submenu.  You can use the Expand All to 
view all of the items under each letter of the alphabet or Collapse All to return to 
letters of the alphabetic listing.  You can individually expand or collapse a letter of the 
alphabet by pressing or .  

SECTION 3 SEARCHING FOR A FEATURE

You can use the search function of the Wizard to locate a specific feature or use a 
keyword to find a group of related features. The example below shows entering the 
exact feature name to locate the feature and entering a keyword to locate a group of 
similar features.  Start the search by either pressing the magnifying glass icon or 
pressing Enter.   
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SECTION 4 PROGRAMMING LEVELS

There are three levels in which feature programming is grouped.  You can apply 
program filters to system data programming: 

 Level 1 – are the most commonly assigned programs for a feature.

 Level 2 – are the next most commonly assigned programs for a feature.

 Level 3 – are programs that are not often assigned for a particular feature and 
require an expert level working knowledge of the system to be properly 
assigned.  

To show the level of programming for a feature:

1. Press the desired level to view the programs assigned at that level.

2. Select a feature.  

Level 1 Level 2 Level 3
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SECTION 5 USING WIZARDS

When you select a feature from the Wizard list the associated screen is displayed, 
allowing you to program the feature.  If there is more than one screen that is 
programmed for the feature, you can use the Next and Back navigational buttons to 
switch between screens or you can use the View page in wizard pulldown menu. 

Figure 5-2  Wizard Programming

Wizard Name View Page in Wizard Program Navigational 
Buttons

Operational 
Buttons

1) Select a 
Wizard.

2) Program 
system data.

3) Change the Wizard page by selecting the page from the 
pulldown menu or pressing either the Next or Back 
navigational buttons.
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To use a Wizard to program a feature:

1. Select the feature Wizard from the Wizard View submenu.

2. Modify the desired settings on the screen.

3. Navigate to the next screen in the Wizard by either selecting the desired page 
from the View page in wizard or by pressing the Next or Back navigational 
buttons.

4. Complete steps 2 and 3 until all screens are finished.

5. Apply the changes.

When programming a Wizard, changes to system data are applied:

 when you press the Apply button.

 when you move to a different page in the Wizard.

 when you exit the Wizard, except in the case when the Cancel button is pressed.

The Cancel button only discards changes made on the current screen. It will not 
undo all changes made in the Wizard.
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Chapter 6 System Data View

SECTION 1 OVERVIEW

System Data represent systems settings as per the categorization used by main 
software. This categorization separates settings into System Data items called ‘PRGs’ 
(programs). PRGs are identified by their ID and name. The ID and name indicate what 
settings the System Data is related to. An example of a PRG identifier can be seen 
below, ‘10-02’ is the ID and ‘Location Setup’ is the name:

10-02: Location Setup

PRGs are grouped by their relationship into ‘PRG Groups’. PRG Groups are identified 
by their ID and name. The ID and Name indicate what settings the System Data is 
related to. An example of a PRG identifier can be seen below, ‘10-XX’ is the ID and 
‘System Configuration’ is the name:

10-XX: System Configuration

Since System Data Programming does not group together the programs for a 
function/feature as with Wizards and Standard screens, System Data Programming is 
intended for advanced users of PCPro who are very familiar with programming a 
system. 
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Figure 6-1  System Data Submenu

Window View: Clicking this 
icon displays the flyout, which 
allows you to select how you 
want the System Data submenu 
displayed.  Right mouse clicking 
also displays this menu.

Auto Hide: Clicking this icon 
hides the System Data 
submenu list and docks the 
tabs on the left side of the 
screen.

Close: Clicking this icon 
closes the System Data 
submenu list and tabs. 
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SECTION 2 ACCESSING SYSTEM DATA VIEW

To access System Data View, complete one of the following:

 Select the menu item Programming > System Data.

    or…

 Select the toolbar icon depicting the blue block .

    or…

 Press F1.

    or…

 If the Programming submenu area is currently open, select the System Data 
tab depicting the blue box, located at the bottom on the submenu.    

The System Data View Menu appears in the submenu area. System Data is grouped 
by PRG Groups and ordered numerically by ID.  You can use the Expand All to view 
all of the items under each Program Number or Collapse All to return to the numeric 
program listing.  You can individually expand or collapse a program number pressing 

or .  
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SECTION 3 SEARCHING FOR A PROGRAM

You can use the search function of Program Data to locate a specific program or use 
a keyword to find a group of related programs. The example below shows entering a 
program number to locate a specific program and entering a keyword to locate a 
group of similar programs.  Start the search by either pressing the magnifying glass 
icon or pressing Enter.   
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SECTION 4 SYSTEM DATA PROGRAM FILTERING

When selecting programs from the system data list, you can select from the following 
filters:

  – shows all system data.

  – shows only unsaved system data.

  – show only system data that needs to be uploaded.

  – shows only system data that is unsaved and needs to be uploaded.

To show the level of programming for a feature:

1. Select a program.

2. Press the desired filter and view the filtered programs.  

Filter 2 Filter 3 Filter 4Filter 1
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SECTION 5 USING SYSTEM DATA

System Data screens are intended for advanced users who are very familiar with 
using PCPro.  If you are not familiar with PCPro, you should use either the Standard 
View or Wizards.  Standard View and Wizards are grouped together to help walk you 
through system data necessary for programming various features of the system. 

Figure 6-2  System Data Programming

Pull down menu to 
changed system data 
item being viewed. 

View Previous 
item. 

View Next 
item. 

Filter

Mouse over for 
help information.

2)  Modify system 
data items.

1)  Select system 
data.
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To modify system data:

1. Select a PRG from the System Data View submenu.

2. Modify the desired settings on the screen.

3. Press the Apply button to save the changes.

When programming system data, changes are applied:

 when the Apply button is pressed.

 when the you change the system data item link.

 when you modify the current system data item filter.

 when you exit System Data View, except when the Cancel button is pressed.
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Chapter 7 Menu and Toolbar Reference 

SECTION 1 OVERVIEW

This chapter provides a table that can be used as a reference between the menus, 
toolbar icons and keyboard shortcuts.  Most functions have more than one method for 
accessing it.  Any submenus are listed with their associated menu. 

SECTION 2 MENUS AND TOOLBARS

The menu (located at the top of the screen) allows access to a list of functions 
provided by PCPro.   The toolbar provides a graphical icon interface to some of the 
more commonly used functions.

Figure 7-1  Menu and Toolbar

Menu

Toolbar
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Table 7-1 Menus lists the menu options, provides a brief description of the menu and 
shows an graphical representation of the menu display.  Some menu items have a 
flyout, indicated by the , which provides additional options for that selection.

Table 7-1  Menus 

Menu Description Menu Display

File This  menu provides access to:

 functions related to creating and 
saving files

 sending  an e-mail with an active 
configuration attached

 displaying the properties for an 
active configuration

 allowing users to log off and log 
in as a different user

 exiting PCPro

View This menu allows you to:

 show/hide the Toolbar

 show/hide the Status Bar

 show/hide the Tool Tips

 show/hide the Submenu Area

Programming This menu provides access to:

 view/edit system settings via the 
Standard screens

 view/edit system settings via the 
Wizards

 view/edit system settings via 
System Data

 search system settings 

 view/edit blade configurations

 list unregistered telephones

 view/edit settings for Telephone 
Types

 list unregistered trunks

 set the system time

 make multiple assignments for 
Account Codes, Appearance 
Keys, Extensions, and Function 
Keys
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Communications This  menu allows you to:

 connect/disconnect to/from the 
system via PCPro

 download (transfer settings) from 
the system to PCPro

 upload (transfer settings) from 
PCPro to the system

 connect to the system in 
Interactive Mode

 view system maintenance logs 
for alarms, call charges, 
resources and traffic

 register features

 update main system firmware

 reset (reinitialize) the system

 backup a database from or 
restore a database to a flash key

Tools This menu provides access to:

 run ARS Simulator

 view/generate Reports

 import DID translation tables and 
speed dial settings

 export DID translation tables, 
speed dial settings and DESI 
label data

 apply Navigation filters for 
extensions and trunks

 view/edit PCPro Accounts

 view/edit Connection Accounts

 default un-initialized system data

 create firmware package

Links This menu allows you to:

 launch WebPro

 launch debug terminal

 launch any other NEC software 
(ACD Server, ACD Agent client, 
etc.)

Help This  menu provides access to:

 online documentation

 register your PCPro software

 display the application version, 
the version and copyright date for 
the main software to which 
PCPro is connected

Table 7-1  Menus  (Continued)

Menu Description Menu Display
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Table 7-2 Menu/Toolbar Hierarchy and Keyboard Shortcut Cross-Reference provides 
a list of the main menu items listed on the menu bar.  Any associated submenus are 
listed in the Submenu Level 1, Submenu Level 2 and Submenu Level 3 columns.  If a 
toolbar icon or shortcut key is available for the menu item, it is listed in the Toolbar 
Icon and Shortcut Key Sequence columns.  

Table 7-2  Menu/Toolbar Hierarchy and Keyboard Shortcut Cross-Reference 

Main Menu 
Item

Submenu Level 1 
Item

Submenu Level 2 
Item

Submenu Level 3 
Item

Toolbar
Icon

Shortcut 
Key 

Sequence

File New SV8100 North America SV8100 R4.0
Ctrl + N

SV8100 R4.0 
(UX5000 defaults)

SV8100 R3.0

SV8100 R2.5

SV8100 R2.0

SV8100 R1.1

SV8100 R1.0

IPKII North America V2100

V2000

V1600

V1500

V1100

V1000

Open…
Ctrl + O

Save
Ctrl + S

Save As…

Send

Properties

Log off

Exit
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View Toolbar

Status Bar

Tool Tips Display Tool Tips

Display for 5sec

Display for 10sec

Display for 20sec

Display for 30sec

Submenu Area

Programming Standard F9

Wizards F10

System Data F11

Search F3

Card Configuration

Unregistered Phones IP Phone List

Mobile Extension List

Unused Phone List

Telephone Types

Unregistered Trunks Unused TrunK List

Time Settings

MultiAssign Account Codes…

Call Appearance 
Keys…

Direct Inward Dial 
(DID)...

Extension Numbers…

Function Keys…

Table 7-2  Menu/Toolbar Hierarchy and Keyboard Shortcut Cross-Reference  (Continued)

Main Menu 
Item

Submenu Level 1 
Item

Submenu Level 2 
Item

Submenu Level 3 
Item

Toolbar
Icon

Shortcut 
Key 

Sequence
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Communications Connect/
Disconnect…

   F5

Download… F6

Ctrl + D

Upload… F7

Ctrl + U

Interactive Mode

Maintenance Alarms

Call Charge

Resource

Traffic

DIM File Download

Feature Activation…

Firmware Update…

System Initialization...

External Storage Backup

Restore

Tools ARS Simulator

Reports Call Appearance Keys

Class of Service

Maintenance Alarms

Other

Modification History...

Non Default Value...

Numbering Plan

System Configuration

Table 7-2  Menu/Toolbar Hierarchy and Keyboard Shortcut Cross-Reference  (Continued)

Main Menu 
Item

Submenu Level 1 
Item

Submenu Level 2 
Item

Submenu Level 3 
Item

Toolbar
Icon

Shortcut 
Key 

Sequence
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Tools (continued) Reports (continued) System Data…

Verify… F8

Feature Activation

Import DID Table...

Speed Dials…

IPK Converted File

IPKII PCPro File

Export DID Table...

Speed Dials…

DESI Labels...

Navigation Filters Extension...

Trunks...

PCPro Accounts…

Connection 
Accounts…

Default Un-initialized 
System Data

Create F/W Package

Links WebPro

DebugTerm

Help Help Topics F1

Register PCPro…

About PCPro

Table 7-2  Menu/Toolbar Hierarchy and Keyboard Shortcut Cross-Reference  (Continued)

Main Menu 
Item

Submenu Level 1 
Item

Submenu Level 2 
Item

Submenu Level 3 
Item

Toolbar
Icon

Shortcut 
Key 

Sequence
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Appendix A MultiAssign

SECTION 1 OVERVIEW

To shorten the time needed to program certain system data, PCPro provides a series 
of special purpose dialogs. These dialogs enable you to set multiple values with ease.

SECTION 2 ACCESSING MULTIASSIGN DIALOGS

To access the various dialogs available for the MultiAssign option, select 
Programming > MultiAssign from the toolbar (refer to Figure A-1 Accessing the 
MultiAssign Dialogs on page A-2).  Select the desired option for assigning:

 Account Codes

 Call Appearance Keys

 Direct Inward Dialing 

 Extension Numbers

 Function Keys
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Figure A-1  Accessing the MultiAssign Dialogs
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SECTION 3 ASSIGNING ACCOUNT CODES

The Account Codes multi-assignment dialog enables the user to set a range of 
account codes. This saves valuable time over having to enter each account code 
individually.

The Account Codes dialog box is accessed by selecting Programming > 
MultiAssign > Account Codes from the toolbar. 

To assign a range of account code BINs with numbers:

1. Specify the begin/end BIN range over which to iterate.

2. Specify the account code number to being the assignment.

3. Specify by how much each account code is to be incremented. For example, a 
value of 2 means accounts codes will increment by 2 for each BIN (i.e. 0001, 
0003, 0005…).

4. Click the Apply button to trigger the assignment.

Figure A-2  MultiAssignAccount Codes

1)  Specify 
Account Code 
BIN range.

2)  Specify Account
Code number with 
which to begin 
assignment.

3)  Specify the 
number indicating 
how much to 
increment each 
Account Code.

4)  Click Apply to assign the 
specified Account Codes.
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Example

To assign BINs 001 ~ 010 with account codes 00001 ~ 00019 in increments of 2:

1. Place a 1 in the Begin at Verified Account Code Bin edit box.

2. Place a 10 in the End at Verified Account Code Bin edit box.

3. Place 00001 in the Begin the assignment use the Account Code edit box.

4. Place 2 in the Increment Account Codes by edit box.

5. Click Apply.

The result will be…

BIN 001 = 00001
BIN 002 = 00003
BIN 003 = 00005
…
BIN 010 = 00019

SECTION 4 ASSIGNING CALL APPEARANCE KEYS

The Call Appearance Keys multi-assignment dialog enables you to set up a group of 
function keys as CAP keys for multiple telephones. The dialog can be used to set up 
many telephones to have the same set of CAP keys or unique CAP keys across the 
telephone group.

The dialog is found under the menu item Programming > MultiAssign > Call 
Appearance Keys.  

When using the Call Appearance Keys dialog, you should begin by deciding how the 
CAP keys should be setup. The choices are:

1. Same on all phones.

2. Unique CAP number to each key.
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4.1 Assigning the Same CAP Keys on All Telephones

In this mode, the same CAP keys appear on all the selected telephones.   

Figure A-3  MultiAssignmentCAP Keys (Same)

3)  Click the Setup box.  When the dialog box is displayed, 
click Same and click OK.
An informational message is displayed indicating the same 
CAP keys will be applied to the selection. 

2)  Select the function 
keys to be set by clicking 
in the check boxes.

1)  Select the 
telephones.

(Optional) Click 
Go to view the 
assignments.

4)  Click Apply 
to trigger the 
assignment.
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To assign a group of telephones: 

If you want to view previous assignments, press the Go button.

1. Select the telephones from the Telephones list by clicking the check 
boxes.

2. Select the function keys that you want to assign to the selected 
telephones by clicking the Function Key checkboxes.

3. Click the Setup box to display the assignment type dialog box.  Click the 
Same button and click Specify if using CTI checkbox if appropriate.  
Enter the starting CAP key number in the Start the assignment with 
CAP field.

4. Click OK.  The main CAP key assignment dialog is returned with the 
assigned numbers displayed.

If required, edit the actual value for each function key that is displayed in 
the Function key checkbox.

5. Click the Apply button to trigger the assignments.

Example

To setup extensions 101 ~105 to have function keys 1~8 set as CAP Keys 
0010~0017 follow the steps below:

 This example assumes CAP numbers 0010 and onwards are not used and CAP 
number 0010 is the first free call appearance number.

1. Select extensions 101~105 from the telephone list.

2. Click function keys 1~8 (i.e., click all items in the first row of function 
keys).

3. Click the Setup box to display the assignment type dialog box.  Click the 
Same button, click Specify if using CTI checkbox if appropriate, enter 
the starting CAP key number in the Start the assignment with CAP 
field.

4.  You will see function keys 1~8 given the values 0010 ~ 0017. 

5. Click the Apply button to trigger the assignments.

The result will be…   

Ext 101 Ext 102 Ext 105

Key 1 = CAP 0010 Key 1 = CAP 0010 Key 1 = CAP 0010

Key 2 = CAP 0011 Key 2 = CAP 0011 … Key 2 = CAP 0011

… … …
Key 8 = CAP 0017 Key 8 = CAP 0017 Key 8 = CAP 0017
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4.2 Assigning Unique CAP Number to Each Key

In this mode, a unique CAP number is assigned to each selected function key 
across all the selected telephones.   

Figure A-4  MultiAssignmentCAP Keys (Same)

3)  Click the Setup box.  When the dialog box is displayed, 
click Unique and click OK.
An informational message is displayed indicating a Unique 
CAP key will be applied to the selection. 

2)  Select the function 
keys to be set by clicking 
in the check boxes.

1)  Select the 
telephones.

(Optional)  Click 
Go to view the 
assignments.

4)  Click Apply 
to trigger the 
assignments.
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To assign a group of telephones:

If you want to view previous assignments, press the Go button.

1. Select the telephones from the Telephones list by clicking the check 
boxes.

2. Select the function keys that you want to assign to the selected 
telephones by clicking the checkbox.

3. Click the Setup box to display the assignment type dialog box.  Click the 
Unique button and click Specify if using CTI checkbox if appropriate.  
Enter the starting CAP key number in the Start the assignment with 
CAP field.

4. Click OK.  The main CAP key assignment dialog is returned with the 
assigned numbers displayed.

If required, edit the actual value for each function key that is displayed in 
the Function key checkbox.

5. Click the Apply button to trigger the assignments.

Example

To setup extensions 101~105 to have unique CAP keys across function keys 
1~8 follow the steps below:

This example assumes CAP numbers 0010 and onwards are not used 
and the CAP number 0010 is the first free call appearance number.

1. Select extensions 101~105 from the telephone list.

2. Click function keys 1~8 (i.e. click all items in the first row of function 
keys).

3. Click the Setup box to display the assignment type dialog box.  Click the 
Same button, click Specify if using CTI checkbox if appropriate, enter 
the starting CAP key number in the Start the assignment with CAP 
field.

4. Enter 0010 in the Start with CAP number edit box. Or alternatively click 
the “…” button and select CAP 0010 from the selection box.

5. Click the Apply button to trigger the assignments.
The result will be… 

Ext 101 Ext 102 Ext 105

Key 1 = CAP 0010 Key 1 = CAP 0018 Key 1 = CAP 0026

Key 2 = CAP 0011 Key 2 = CAP 0019 … Key 2 = CAP 0027

… … …
Key 8 = CAP 0017 Key 8 = CAP 0025 Key 8 = CAP 0033
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SECTION 5 ASSIGNING DIRECT INWARD DIAL (DID) NUMBERS

DID allows you to assign multiple DID table entries.

The dialog is found under the menu item Programming > MultiAssign > Direct 
Inward Dial (DID).

To assign DID entries:

1. Enter the DID Translation Table Entry number to begin the assignment.

2. Specify the number of indials.

3. Enter the starting Received Number.

4. Specify either Extension or Dial number by clicking the associated button.

5. Use the pulldown menu to select the appropriate Target Number.

6. Click the Apply button to trigger the assignments.

Figure A-5  MultiAssignDirect Inward Dialing (DID)

1)  Enter the 
DID Translation 
Table number.

6)  Click Apply 
to trigger the 
assignments.

2)  Specify the 
number of indials.

3)  Enter the starting 
Received Number.

5)  Select the starting 
Target Number.

4)  Click either 
Extension or Dial 
number.
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SECTION 6 ASSIGNING EXTENSION NUMBERS

The Extension Number multi-assignment dialog enables you to set a range of 
extension numbers to ports. This saves valuable time over having to enter each 
extension number individually.  In addition, the dialog allows you to set blank 
extensions, thus providing a convenient way of freeing extension numbers for use by 
other ports.

The dialog is found under the menu item Programming > MultiAssign > Extension 
Numbers.   

Figure A-6  MultiAssignmentExtension Numbers

1)  Select 
extension type.

2)  Specify beginning 
and ending port 
numbers in the range.

4)  Click Apply 
to trigger the 
assignments.

3)  Enter the extension 
number used to begin 
assignment (or leave 
blank to clear numbers).
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To assign a group of ports with extension numbers:

1. Select the type of extensions you want to apply.

2. Specify the port range over which to iterate.

3. Specify the extension number to begin the assignment. (Leave this field blank to 
clear the extension numbers).

4. Click the Apply button to trigger the assignment.

Example

To assign telephone ports 001~099 with extension numbers 301~399:

1. To assign station numbers select 11-01: Extension Numbering as our extension 
type.

2. Place a 1 in the Begin at Station Port edit box.

3. Place a 99 in the End at Station Port edit box.

4. Place 301 in the Begin the assignment use the extension edit box.

5. Click Apply.

The result will be…
Port 001 = Ext 301
Port 002 = 302
Port 003 = 303
…
Port 099 = 399

The extension numbers must validate against the numbering plan setup in 
PRG-11-01. In addition, duplicate extension numbers cannot exist. In this case, free 
the extension numbers by assigning a blank to the ports using those extension 
numbers.
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SECTION 7 ASSIGNING FUNCTION KEYS

The Function Keys multi-assignment dialog enables you to setup a group of function 
keys for multiple telephones. The dialog is best used if you need to set up many 
telephones to have the same set of function keys.

The dialog is found under the menu item Programming > MultiAssign > Function 
Keys.   

Figure A-7  MultiAssignmentFunction Keys

1)  Select 
telephones.

7)  Click Apply 
to trigger the 
assignments.

2)  Select Function 
Keys to set by clicking 
the checkbox.

4)  If assigning 
keys as Trunk 
Keys (i.e., line 
keys), select 
the starting 
trunk number.

3)  Select 
Function type.

5)  Select the 
Sequence type.

6)  Click Assign 
to preview the 
result.
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To assign Function Keys:

1. Select the telephones from the Telephones list by ticking the check boxes.

2. Select the function keys to set by clicking the checkbox.

3. Select the Function Type.

4. Specify the starting Trunk Number.

5. Select the Sequence type.

6. Click the Assign button. PCPro assigns selected function keys with trunk 
numbers, beginning with the trunk specified in step 4. The values have not been 
set to system data yet. This is only a preview.

7. Click the Apply button to trigger the assignment.

Example

To setup extensions 101 ~105 to have function keys 1~8 set as Trunk Keys 10~17 
follow the steps below:

1. Select extensions 101~105 from the telephone list.

2. Tick function keys 1~8 (i.e., tick all items in the first row of function keys).

3. Set the function type to Trunk Key.

4. In the Start with Trunk edit box type 10. Alternatively, click the “…” button and 
select trunk 10 from the list. 

5. Click the Apply button to trigger the assignment.
The result will be…    

Ext 101 Ext 102 Ext 105
Key 1 = Trunk 10 Key 1 = Trunk 10 Key 1 = Trunk 10
Key 2 = Trunk 11 Key 2 = Trunk 11 … Key 2 = Trunk 11

… … …
Key 8 = Trunk 17 Key 8 = Trunk 17 Key 8 = Trunk 17
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-- NOTES --
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Appendix B Communications

SECTION 1 OVERVIEW

PCPro provides methods for the application to communicate with the chassis.  PCPro 
can connect to the chassis to allow you to download/upload data, to perform a system 
initialization, to update firmware, to activate features and to backup a database to or 
restore a database from a flash key.

SECTION 2 CONNECT/DISCONNECT

Connect/Disconnect makes or breaks a connection session between PCPro and a 
chassis.  This option changes its functionality depending on the connection status of 
PCPro.  Figure B-1 Connect/Disconnect Status shows how the connection status is 
indicated on the toolbar.   

2.1 Accessing Connection Dialog

Connecting PCPro to a system is done within the Connect dialog. While 
PCPro is disconnected from a system, access the Connect dialog using one of 
the following three methods.

 Select the menu item Communications > Connect/Disconnect.

    or…

Figure B-1  Connect/Disconnect Status

Disconnected Signifies that PCPro is not connected to the chassis.

Connected Signifies that PCPro is currently connected to the chassis.

Connect/Disconnect Status
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 Select the icon depicting the disconnected black and yellow plugs .

    or…

 Press F5.

2.2 Connecting PCPro to the System

Use the Connect dialog box to specify connection parameters to connect to 
the system.

Figure B-2  Connect Dialog

3)  (Optional) Load 
a defined 
Connection 
Account (can skip 
steps 1~3 by using 
this option.

1)  Select 
Connection Type.

2)  To login, specify 
the User Name and 
Password.

4)  To make the 
connection to the 
system, click 
Connect.
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Figure B-3  IPKII Connect Dialog

3)  (Optional) Load 
a defined 
Connection 
Account (can skip 
steps 1~3 by using 
this option.

1)  Select 
Connection Type.

If connecting to an 
IPK II system, select 
either Direct or 
Modem Connection 
Type.

2)  To login, specify 
the User Name and 
Password.

4)  To make the 
connection to the 
system, click 
Connect.
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To make a connection between PCPro and the system:

1. Select a Connection Type and specify the settings relevant to the 
selected type.  

If connecting to an SV8100 system, select either IP or IP via Dial-up.

If connecting to an IPK II system, select either LAN, Direct or Modem.

2. Specify the User Name and Password used to allow the connection.

3. Alternatively, steps 1~2 can be skipped loading a defined connection 
account (refer to Appendix E - Connection Accounts).

4. Press the Connect button.

After a successful connection, the connection settings that are used are 
set to the File Properties.

2.2.1 Connection Types

PCPro supports four types of connections to a system. Two 
connection types are for SV8100 and three apply only to IPK II. 

Connection Types for SV8100: 

 IP
An IP Connection can be made via a LAN or the Internet. The IP 
address specified should match the system setting 10-12-01. If 
connecting to the ethernet port on the VoIP daughter board, use the 
IP address setting in 10-12-09.

 Dial-up
An IP Connection via Dial-up can be made via a dial-up connection, 
either through ISDN or an analog modem.

To install dial up connection, refer to paragraph 2.2.2 Create SV8100 Dial
Up Connection on page B-5.

Connection Types for IPK II only: 

 LAN
An IP Connection can be made via the LAN.  The IP address 
specified should match the system setting 10-12-01.

 Direct
A Direct Connection can be made via an available serial port on a PC. 
Specify the PCs serial port and its transfer rate (bps). This speed 
must match the KSU baud rate setting assigned in 10-21-02.
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 Modem
A Modem Connection can be made from an existing modem 
connected to the PC. Specify the modem number to dial.

To access the modem over K-CCIS, route the modem access service code to
the target switch.  Do not call a station that is call forwarded to the service
code. When accessing the modem over K-CCIS, enter the service code to be
dialed in PCPro.  

Note that PCPro follows the PCs dialing properties. If dialing a service code,
you must turn off the dial 9 for outside line and area code inclusion or PCPro
will dial these digits as well.

2.2.2 Create SV8100 Dial Up Connection

When connecting an SV8100 via modem, a Dial Up Connection 
(PPP) must be created.  The following steps describe how to set up 
the Dial Up Connection (PPP).

1. Click Start >Settings>Network Connections.

2. Select Create a New Connection.  

3. Click Next.

4. Select Connect to the network at my workplace, then click 
Next.

Figure B-4  New Connection Wizard Dialog
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5. Select Dial-up connection, then click Next.  

Figure B-5  Network Connection Type Dialog

Figure B-6  Network Connection Dialog
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6. Enter a name to be used for the dial-up connection.  

7. Enter the telephone number to be dialed, then click Next.

Ensure the SV8100 programs 11-15-14, 22-02 and 22-07 are setup to 
receive calls to the modem.  

Figure B-7  Connection Name Dialog

Figure B-8  Phone Number to Dial Dialog
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8. Setup the availability of the connection, then click Next.  

9. Click Finish.  

Figure B-9  Connection Availability Dialog

Figure B-10  Completing the New Connection Dialog
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10. In the Connection window click Properties and select the 
Security tab.   

Figure B-11  Connect SV8100 Dial Up Connection
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11. Select Typical and click OK.  Setup for the Dial Up Connection 
(PPP) is complete.  

2.2.3 Login

Specify the User Name and Password that will allow the connection. 
The account must exist within the chassis settings 90-02. Like PCPro 
Accounts, Login Accounts govern what system data can be 
accessed from the chassis.

It is important to note, Login Accounts are not the same as PCPro 
Accounts. Thus both chassis Login and PCPro Account settings are 
NOT synchronized and are independent of each other.

Once connected, the PCPro access level changes to match the level 
assigned to the user name/password used to connect. This access 
level is set in 90-02 on the chassis. For example, if you start PCPro 
in Installer (IN) mode, but connect to a chassis using an account with 
an access level of System Administrator Level 1 (SA), after 
connecting PCPro assumes the access level of SA. Once you are 
disconnected, PCPro reverts back to the access level IN.

Figure B-12  SV8100 Dial Up Connection Properties
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2.3 Disconnecting PCPro from the System

While PCPro is connected to a system, you can disconnect using one of the 
following methods:

1. Select the menu item Communications > Connect/Disconnect.

    or…

2. Select the icon depicting the connected black and yellow plugs .

or…

3. Press F5.

All communication methods, excluding ‘Connect/Disconnect’, are disabled 
and the ‘Connect/Disconnect’ toolbar icon changes status to disconnected.

SECTION 3 DOWNLOAD

Downloading pulls all the data off the system and loads it into PCPro. A download can 
only occur when PCPro is connected to a system.

3.1 Accessing Download

When PCPro is connected to a system, access the Download dialog using one 
of the following methods.

 Select the menu item Communications > Download.

    or…

 Select the icon depicting the blue arrow .

    or…

 Press F6.
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3.2 Downloading Data from the System to PCPro

Use the Download dialog to specify the parameters and perform a download. 

To download data from system memory to PCPro:

1. Select a Transfer Type.

2. Select Transfer Type items.

3. If desired, select items via the Modify Filter.

4. Press the Start button.

5. After the download is completed, press the Close button.

Figure B-13  Download Dialog

3)  Apply filter 
to help find 
items.

1)  Select 
Transfer Type.

2)  Select 
additional 
item(s) to 
download.

4) Click Start to begin 
download.

5) When completed, click 
Close.
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3.2.1 Transfer Type

Select a filter that controls the scope of settings to download. The 
following Transfer Types are made available.

 All: No filter, all chassis settings.

 Blade Configuration: Blade package settings.

 System Data Partial (System Wide): System-based settings.

 System Data Partial (Telephone): Telephone-based settings.

 System Data Partial (Virtual Extension): Virtual Extension-based 
settings.

 System Data Partial (Trunk): Trunk-based settings.

 User Data: User-specific settings.

Transfer Type Items

Specifically select PRG Groups and/or individual PRGs from the 
chassis settings to download. The choice of Transfer Type Items 
available is governed by the Transfer Type selected.

Modify Filters

A  filter is applied based on the system data modification status. The 
filter only applies to system data on the PCPro side, not system data 
residing in chassis memory.  Refer to Appendix D - Modification 
History for further information.

SECTION 4 UPLOAD

Uploading pushes all the data from PCPro to system memory. An upload can only 
occur when PCPro is connected to a system.

4.1 Accessing Upload

When PCPro is connected to a system, access the Upload dialog using one of 
the following methods:

 Select the menu item Communications > Upload.

    or…

 Select the icon depicting the red arrow .

    or…

 Press F7.
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4.2 Uploading Data from PCPro to System Memory

Use the Upload dialog to specify the parameters and perform an upload. 

To upload data from PCPro to system memory:

1. Select a Transfer Type.

2. Select Transfer Type items.

3. If desired, select items via the Modify Filter.

4. Press the Start button.

5. After the upload is completed, press the Close button.

Figure B-14  Upload Dialog

3)  Apply filter 
to help find 
items.

1)  Select 
Transfer Type.

2)  Select 
additional 
item(s) to 
upload.

4) Click Start to begin 
download.

5) When completed, click 
Close.
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4.2.1 Transfer Type

Select a filter that controls the scope of chassis settings to upload. 
The following Transfer Types are made available.

 All: No filter, all Chassis settings.

 Blade Configuration: Blade packages settings.

 System Data Partial (System Wide): System-based settings.

 System Data Partial (Telephone): Telephone-based settings.

 System Data Partial (Virtual Extension): Virtual Extension-based 
settings.

 System Data Partial (Trunk): Trunk-based settings.

 User Data: User-specific settings.

Transfer Type Items
Specifically select PRG Groups and/or individual PRGs from the 
chassis settings to upload. The choice of Transfer Type Items 
available is governed by the Transfer Type selected.

Modify Filters
A filter is applied based on the system data modification status. The 
filter only applies to system data on the PCPro side, not system data 
residing in chassis memory.  Refer to Appendix D - Modification 
History for further information.

4.3 Uploading Blade Configuration 

When uploading the Blade Configuration via Upload All, and selecting Card 
Configuration, or just Uploading Card Configuration, a warning popup will 
display when either Trunks or stations are busy at the time of selecting to 
uploading the Card Configuration.  This will allow for the upload to be 
cancelled and completed at a later time, or to be continued and will disconnect 
the busy trunks and/or stations. 

This popup is shown when the Card Configuration is selected to be uploaded 
and the trunks are busy. 

Figure B-15  Trunk Ports Busy Warning
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This is popup is shown when the Card Configuration is selected to be 
uploaded and stations are busy.  

SECTION 5 FEATURE ACTIVATION

Some system features are licensed and require registration before they can be used.  
Features can be activated by registering the feature automatically via the Internet or 
manually by downloading the associated Software Code.  Feature Activation can only 
occur when PCPro is connected to a system.  

5.1 Accessing Feature Activation

When PCPro is connected to a chassis, access the Feature Activation dialog 
by selecting the menu item Communications > Feature Activation.

Figure B-16  Station Ports Busy Warning
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5.2 Activating a Feature
Refer to Appendix G - Feature Activation for a detailed discussion.

Figure B-17  Feature Activation Dialog

Select to automatically 
register.  (Refer to 
Appendix G - Feature 
Activation for detailed 
instructions.)

Select to manually 
register.    (Refer to 
Appendix G - Feature 
Activation for detailed 
instructions.)
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SECTION 6 FIRMWARE UPDATE

Firmware Update automatically updates the main software in a system remotely at a 
scheduled time. This feature saves times and effort in comparison to performing the 
task manually.  A Firmware Update can only occur when PCPro is connected to a 
chassis.    

The time to upload the firmware package file is directly related to the file size. 
At present, the package file is about 10MB, so over LAN it may take several 
minutes.

A backup of system data should be performed before any firmware update.

Figure B-18  Firmware Update Dialog
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Before Firmware Update can be used the system must meet the following 
requirements:

1. Feature Activation
The Firmware Update feature must be registered through Feature 
Activation. Refer to Section 5 Feature Activation on page B-16 for 
details.

2. Hardware
The hardware prerequisite for Firmware Update is the USB drive. The 
USB drive is used to store the Firmware Update file before the operation 
is executed.

6.1 Accessing Firmware Update

When PCPro is connected to a chassis, access the Firmware Update dialog 
by selecting the menu item Communications > Firmware Update.

6.2 Using Firmware Update

Use the Firmware dialog to specify the parameters and perform a Firmware 
Update.

To perform a firmware update:

1. Select a Firmware File.

Firmware Package File:
Select a Firmware package file provided by NEC. Updating a chassis with a 
faulty Firmware page file could render the system unusable.

2. Schedule when the Firmware Update is to occur using the parameters in 
the Schedule Update section.

Schedule:
Schedule when the Firmware update will occur. The changes of the 
Firmware Update will only occur after the chassis is reset. Thus the 
Firmware Update should be executed at a suitable time when the 
chassis is not actively in use.

 The time you specify should be relative to the time on the chassis, not the local time 
of the PC.

3. Press the Start button.
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SECTION 7 SYSTEM INITIALIZATION

A System Initialization resets a system. During an initialization all telephone calls are 
dropped and all connections to WebPro, PCPro and the handset are lost.  Therefore, 
it is important that initialization should be executed at a suitable time when the system 
is not actively in use.  PCPro can only execute an initialization when it is connected to 
a system. 

7.1 Accessing System Initialization

When PCPro is connected to a system, access the System Initialization dialog 
by selecting the menu item Communications > System Initialization.

7.2 System Initialization Types

Within the System Initialization Dialog, there are two types of initialization.

1st Initialization
A 1st Initialization resets the chassis and loads all system data with factory 
default values. As a result, all previously modified values are lost (only 
available when connected to an IPK II system).

Figure B-19  System Initialization Dialog
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2nd Initialization
A 2nd Initialization resets the chassis and retains all previously modified values 
within system data.
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Appendix C Copy

SECTION 1 OVERVIEW

The system data copy function allows you to copy data from one item to another (e.g., 
one trunk to another).  This copy only applies to a single program. Copy only appears 
on screens where it is applicable.    

Figure C-1  System Data Copy

2) Specify copy source.

3) Specify copy 
destination.

4) Specify data to be 
copied.

5) Click OK to copy.

1) Select copy.
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SECTION 2 COPYING SYSTEM DATA

To copy a system data item: 

1. Press the Copy button .

2. When the Copy dialog box is displayed, specify the source to copy from.

The source (From) shows the item being copied from. Only a single source item 
can be selected.

3. Specify elements of the source that you want to copy.

These settings are specific to the system data being copied.

4. Specify the destination where you want to the elements copied.

The destination (To) details the item(s) where the selected source information is 
copied to. Multiple destination items can be selected.

5. Press OK to copy the selected items.
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Appendix D Modification History

SECTION 1 OVERVIEW

PCPro keeps a record of all the modifications made to a database file. This record is 
known as the Modification History.  PCPro also provides you with the ability to view 
this history list. Following is the list of database operations that PCPro records in the 
modification history.   

Operation Details

System Data Set This includes programming performed through:

 Standard View Screens

 Wizards

 System Data Programming

 Copy

For each set, an entry is made to the history list. The entry records the 
following items:   

Field Data

Date Date and time of operation.

User Name The User Name that performed the operation.

Display Name The Display Name that performed the operation.

Access Level The Access Level that performed the operation.

Type Identifies the operation type.  Set to “Set Date”.

Modification The system data ID.

Details

The item changed.

Old value.

New value.
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The modification history is only saved in the local database when you perform File 
Save or File Save As. The modification history is a running list of the changes. PCPro 
keeps appending to the list. If you open a file, make changes, save and close the file 
and in the future open the same file and make additional changes, then the new 
modification history is appended to the old.

The modification state of a PCPro database is indicated via the modification icon on 
the Status Bar. The different filters are:    

SECTION 2 ACCESSING MODIFICATION HISTORY

To access Modification History, complete one of the following:

 Select the menu item Tools > Reports > Modification History.

               or…

 Select the clock icon on the toolbar .

SECTION 3 GENERATING A MODIFICATION HISTORY REPORT

A Modification History Report can be viewed in either HTML format or Comma 
Separated Variable (CSV) format. Sample formats are shown in Figure D-2 Sample 
Modification History HTML Format on page D-3 and Figure D-3 Sample Modification 
History CSV Format on page D-4. 

To request a report:

1. Access the report by selecting Modification History from the toolbar or by 
clicking the clock icon (refer to Section 2 Accessing Modification History).

2. When the Export Modification History dialog box is displayed, click either the 
HTML or CSV option and press OK. 

The database is not modified. All data has been saved to file and uploaded.

System data has been modified and has not been saved to file.

System data has been saved to file but has not been uploaded.

System data has been modified and has not been saved to file nor uploaded.
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3. The report is generated in the format you selected.  (Refer to Figure D-2 Sample 
Modification History HTML Format and Figure D-3 Sample Modification History 
CSV Format on page D-4).

   

Figure D-1  Export Modification History Dialog Box

Figure D-2  Sample Modification History HTML Format



D - 4

___________________________________________________________________________________

___________________________________________________________________________________Issue 5.0 UNIVERGE SV8100

  

Figure D-3  Sample Modification History CSV Format



PC Programming Manual E - 1

___________________________________________________________________________________

Appendix E Connection Accounts

SECTION 1 OVERVIEW

Connection Accounts provide a convenient way of loading user defined connection 
settings. These are application wide settings.  Connection Accounts can be created in 
two ways:

 Via the Connect dialog

 Via the Connection Accounts dialog

SECTION 2 CREATING/DELETING A CONNECTION ACCOUNT USING THE CONNECT 
DIALOG

This section describes how to use the Connect dialog to create a new Connection 
Account or delete an existing Connection Account.  (Refer to Figure E-1 Connect 
DialogCreating/Deleting Connection Account on page E-2.)
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2.1 Creating a New Account

To create an account using Connect dialog:

1. Select a Connection Type and specify settings relevant to the 
Connection Type.

2. Specify the Login User Name and Password used to allow the 
connection.

3. Press the Save or Save As button located in the Connection Account 
section of the dialog.  

4. When the Save As dialog is displayed, enter a description of the 
connection (refer to Figure E-2 Save As Connection Account Dialog on 
page E-3.)

Figure E-1  Connect DialogCreating/Deleting Connection Account

Click Save or Save As to 
create a Connection 
Account.

Select the 
Connection Type. 

Specify the Login User 
Name and Password.

Select a Connection 
Account from the pulldown 
menu and click Delete a 
Connection Account.
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5. Press OK to save the Connection Account.

2.2 Deleting an Account

An existing Connection Account can be deleted.  

To delete an existing account:

1. Select the Connection Account from the pulldown menu on the 
Connect dialog.  (Refer to Figure E-1 Connect DialogCreating/Deleting 
Connection Account on page E-2.)

2. Click the Delete button.  

Figure E-2  Save As Connection Account Dialog

Enter the Connection 
Account description.

Click OK to save the 
Connection Account.
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SECTION 3 CREATING/MODIFYING/DELETING A CONNECTION ACCOUNT USING THE 
CONNECTION ACCOUNTS DIALOG

This section describes how to create, modify or delete a Connection Account using 
the Connection Accounts dialog.

To access the Connection Accounts dialog, select Tools > Connection Accounts on 
the toolbar.  

3.1 Creating a New Account

To create a new Connection Account:

1. Click the Add button.

2. When the Connection Account Settings dialog is displayed, enter the 
account properties.

3. Click OK to save the Connection Account.

Figure E-3  Connection Account DialogCreating/Modifying/Deleting Connection Account

Click Add to create 
a new Connection 
Account.

Settings
Dialog

Select a Connection 
Account and click 
Remove to delete an 
account.

When adding a new Connection Account, 
click the tabs to set the appropriate values 
and click OK.

Click Properties to 
modify the setting of 
an existing account.
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3.2 Modifying an Existing Account

To modify an existing Connection Account:

1. Select the Connection Account on the Connection Accounts dialog.

2. Click the Properties button.

3. When the Connection Account Settings dialog is displayed, change the 
settings of the selected account.

4. Click OK to save the changes to the account.

3.3 Deleting and Existing Account

To delete an existing Connection Account:

1. Select the Connection Account on the Connection Accounts dialog.

2. Click Remove to delete the selected account.
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-- NOTES --
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Appendix F Debug Terminal 

SECTION 1 OVERVIEW

PCPro provides a debug terminal that can be used to capture trace logs from the CD-
CP00-US in the chassis. The debug terminal communicates with the chassis via the 
LAN.  A TCP connection on port 5963 is established between the debug terminal and 
the chassis.   

Figure F-1  Debug Terminal Dialogs

1) Specify 
connection 
information.

2) Specify the 
log file to be 
used for data 
capture.



F - 2

___________________________________________________________________________________

___________________________________________________________________________________Issue 5.0 UNIVERGE SV8100

SECTION 2 LAUNCHING THE DEBUG TERMINAL

You can launch the debug terminal in one of two ways:

 Select the menu item Links > DbgTerm.

    or…

 Click on the DbgTerm icon on the toolbar  .

   

If PCPro is connected via LAN to a chassis, then the debug terminal automatically 
tries to connect to the same IP address (domain name).  Once the debug terminal is 
running, incoming debug messages from the chassis appear on the screen.  You can 
capture the incoming data to a file by specifying a log file name and enabling the log 
capture.

Log capture can be enabled or disabled at the your discretion. A message is printed in 
the log file indicating the date and time the capture was enabled or disabled.
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Appendix G Feature Activation

SECTION 1 INTRODUCTION

There are three methods for activation of features on the CD-CP00-US: automatic 
activation via PCPro, manual activation via PCPro and manual activation via WebPro. 

SECTION 2 FEATURE ACTIVATION USING PCPRO

Some system features require registration before they can be used.  Feature 
Activation registers these features automatically via the Internet or manually through 
input of Activation Codes.  Feature Activation can only occur when PCPro is 
connected to a system.   

Figure G-1  PCPro Feature Activation Dialog

XXXXXXXXXXXX

Hardware Key (number assigned 
by NEC and printed on equipment).

Informational area that lists features available for activation.  For each feature, 
the quantity registered, the activation status (On = activated, Off = not activated) and 

an expiration date for feature activation (if assigned) is displayed.

Customer 
email 

address, 
required for 
verification.

Customer 
password.

Software 
Code, 

obtained from 
License. 
Sheet.

Automatic  
Registration

Manual  
Registration Request html report 

for license.
Exit Feature 
Activation.
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2.1 Accessing Feature Activation

When PCPro is connected to a chassis, access the Feature Activation dialog 
by selecting the menu item Communications > Feature Activation.

2.2 Automatically Activating a Feature

Automatic Activation requires PCPro to have an Internet connection to 
communicate the NEC Product License Server.  The NEC Product License 
Server provides PCPro with the license file.  The license file contains the 
Software Code, which is required to activate the feature.

To activate a feature automatically:

1. Launch PCPro and access Feature Activation (refer to 2.1 Accessing 
Feature Activation.)

2. If connected to the SV8100 system, the Hardware Code is retrieved and  
displayed.  

3. Enter your email address in the Email field.

 This email address is the same address you provided to the NEC Dealer 
Portal.  

4. Enter your Password (assigned by NEC to access the license server).

Once the email and password are verified, a license file is returned.  This 
file is sent from the license server.

5. Click Auto Register.

6. When the confirmation dialog is returned, click Save & upload now to 
immediately save the file on the ProPro database and activate the 
feature.  (Refer to Figure G-2 Feature Activation Confirmation Dialog on 
page G-3.)

 If you chose Save only, you need to access PCPro and manually activate 
the feature.  Save only saves the file on the PCPro database, but does not 
activate the feature.
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2.3 Manually Activating a Feature

Manual Activation does not require that you have an Internet connection.  
However, you must have previously downloaded the license file that was 
generated by the NEC Product License Server.   The license file contains the 
Software Code, which is required to activate the feature.

To activate a feature manually:

1. Launch PCPro and access Feature Activation (refer to 2.1 Accessing 
Feature Activation).

2. If connected to the SV8100 system, the Hardware Code is retrieved and  
displayed.  

3. Click Load File (refer to Figure G-3 Feature Activation Open File Dialog 
on page G-4). 

 This file can reside on the PC or you can copy it to a flash drive to reference 
if activating other locations.

Figure G-2  Feature Activation Confirmation Dialog

Automatic  
Registration

Manual  
Registration
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4. When you have located the file (xxxxxxx.lic), select it and click Open.

5. When the confirmation dialog is returned, click Save & upload now to 
immediately save the file on the ProPro database and activate the 
feature (refer to Figure G-2 Feature Activation Confirmation Dialog).

Figure G-3  Feature Activation Open File Dialog
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SECTION 3 FEATURE ACTIVATION USING WEBPRO

WebPro can also be used to manually activate features.

3.1 Manually Activating a Feature

To activate a feature using WebPro, you must have Internet connection.

1. Point your browser at the IP address of the CD-CP00-US (set in PGM 
10-12-01).

2. When the Home page is displayed, enter the User Name and 
Password.

The default User Name = tech and Password = 12345678. 

Figure G-4  WebPro Login Screen
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3. If login was successful, the WebPro Home page is displayed.  Click 
Feature Activation.   

Figure G-5  Feature Activation Screen WebPro Home Page
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4. The WebPro License Registration dialog is displayed.  

5. If connected to the SV8100 system, the Hardware Code is retrieved and  
displayed.  

6. In the Upload a license file to the KTS field, click Browse to locate the 
license file (XXXXXXX.lic). 

 This file can reside on the PC or you can copy it to a flash drive to reference 
if activating other locations.

 The license file is obtained by accessing the NEC Product Activation 
Server, or by activating the feature using PCPro (refer to Section 3 Feature 
Activation Using WebPro on page G-5).

7. When the Open dialog is displayed, select the license file and click 
Open.  When prompted to proceed, click Yes.

Figure G-6  Feature Activation Screen WebPro Manual Activation
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8. Click Upload to retrieve the license file.

9. If the license file upload is successful, the feature is activated.

Figure G-7  Feature Activation Open File Dialog WebPro
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3.2 Recovery License

Recovery License allows you to license all the features for 30 days.  Please 
refer to the SV8100 Features and Specifications Manual for more 
information. 

To Activate the Recovery License:

1. Go to https://eip.necunified.com/login.aspx 

2. Input the User Name and Password.

Figure G-8  NEC Information Portal Login Screen

https://eip.necunified.com/login.aspx
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3. Go to the Recovery License section.  

4. Select the Company and Site location.

5. Generate Recovery License.

 You can only have two for each site.

3.3 Further Information

For further information on Feature Activation visit:

https://eip.necunified.com/login.aspx

Figure G-9  Recovery License Access Screen

https://eip.necunified.com/login.aspx
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Appendix H Elite IPK II Database File Conversion

SECTION 1 OVERVIEW

This feature converts an Electra Elite IPK II PCPro database file into a SV8100 PCPro 
database file.

Software Version 3.00 or higher is required for this feature.

SECTION 2 OPERATION

Use the following procedure to perform the database file conversion.

2.1 SV8100 PCPro

1. Select Tools/Import/IPKII PCPro File.  

Figure H-1  Import File Screen
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2. PCPro displays the PIPK Data Conversion Dialog screen. The user 
selects the data file of the Elite IPK II PCPro (.pcp), then clicks the Load 
Data button.  

Figure H-2  PIPK Data Conversion Dialog Screen
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3. PCPro displays the system data list. Select the system data to be 
converted.  

4. When the user clicks Import, the selected system data is converted into 
the SV8100 PCPro Database. For conversion limitations, refer to the 
table shown next.

Figure H-3  System Data List

If “Select All” is checked, then all the data programs in the list will be 
converted.
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The system data to be converted is limited to the system data listed below.  

Program Number Program Name

10-23 IP System Interconnection Setup

11-01 System Numbering

11-02 Extension Numbering

13-04 Abbreviated Dial Number and Name

14-01 Trunk Basic Data Setup

14-02 Analogue Trunk Data Setup

14-05 Trunk Group

14-06 Trunk Group Routing

15-01 Extension Basic Data Setup

15-07 Programmable Function Key

21-02 Trunk Group Routing for Extensions

22-02 Incoming Service Type Setup

22-04 Incoming Ring Group Setup

22-05 IRG Assignment for Normal Ring Trunk

22-07 DIL Assignment

22-11 Dial-In Conversion Table Data Setup

26-01 Automatic Route Selection Service

26-02 Dial analysis Table for ARS/LCR

26-03 ARS Dial Treatments

26-04 ARS Class of Service

26-11 Transit Network ID Table

26-12 Network Specified Parameter Table for ARS/F-Route

40-02 Mail Box Setup

44-02 Dial analysis Table for F-Route Access

44-05 F-Route Table

44-06 Additional Dial Table
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Appendix I UX5000 to SV8100 Database File 
Conversion

SECTION 1 OVERVIEW

SV8100 PCPro version 4.0 supports the ability to open a PCPro database saved by 
UX5000 PCPro (V1.xx ~ V3.xx) and also converting the Database to SV8100 format.  
SV8100 PCPro version 4.0 cannot be used to connect directly to a UX5000 database.  
Only UX5000 PCPro is supported to connect directly to a UX5000 database.

SECTION 2 OPERATION

Use the following procedure to perform a UX5000 to SV8100 database file 
conversion.

2.1 Database Conversion

1. Run UX5000 PCPro and select Communications > Connect  to 
connect to the UX5000 system, Figure I-1 - UX5000 Connection. 

Figure I-1  UX5000 Connection
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2. Once connected, click Communication > Download to download the 
database, Figure I-2 - Download Database Screen.  

Figure I-2  Download Database Screen
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3. After the download is complete, click File > Save or Save As to save the 
UX5000 PCPro database, Figure I-3 - Database Save.  

4. Launch SV8100 PCPro and click File > Open to open the UX5000 
PCPro database saved in Figure I-3 - Database Save. 

Figure I-4  Open Database

5. Click Open on the Open dialog screen, Figure I-4 - Open Database.   
Figure I-5 - Database Conversion Confirmation appears.

Figure I-3  Database Save
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Figure I-5  Database Conversion Confirmation

 If you click OK,  the original UX5000 database is converted to an SV8100 
PCPro database and then opened as an SV8100 PCPro screen.

 If you click Cancel, the UX5000 database is not converted and the previous 
PCPro database remains. 

 All UX5000 PCPro database versions (v1 ~ v3) are supported.

All programs are converted except for the following shown in Table I-1 - Conversion 
Exceptions. 

Table I-1  Conversion Exceptions

PRG No Name

PRG10-07-01 Conversation Record Circuits

PRG10-22-xx Setting the Wake On LAN for APSU

PRG10-41-xx General Purpose Contact Detector 
Setup

PRG11-10-02 Changing the Music on Hold Tone

PRG11-11-06 Call Forwarding (United Method)

PRG11-11-40 VAU/Off-premise call forwarding

PRG11-11-61 Set or Cancel Call Forward for Centrex

PRG11-14-19 Hotel Room Data Set

PRG11-19-01 Remote Conference Pilot Number 
Setup

PRG14-09-04 ACI Automatic Recording for Outgoing 
Call

PRG15-02-09 Auto answer to incoming call from 
Extension

PRG15-03-13 MW sending type

PRG15-03-17 Dial Tone select
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PRG15-05-03 Default URL address

PRG15-05-05 H.323 Terminal Type

PRG15-05-08 H.323 RAS Port

PRG15-05-09 Call Control Port

PRG15-07-01  16:Call Forward to Station
 17:Call Forward to Device
 *30:Call 1 Key
 *31:Call 2 Key

PRG15-12-03 Recording Contents Storing Method 
(DSPDB)

PRG15-12-04 ACI Automatic Recording for Outgoing 
Call

PRG20-01-03 DSP Sender Resource Selection

PRG20-02-03 BLF Control

PRG20-04-01 Virtual Extension Key Operation Mode

PRG20-13-46 Remote Conference

PRG20-17-02 Operator Console Mode

PRG20-19-03 Caller ID Edit Mode

PRG20-34-xx Remote Conference Group Setup

PRG24-06-01 Fixed Call Forwarding

PRG24-07-01 Fixed Call Forwarding Off Premise

PRG24-08-xx Call Forward for Centrex

PRG26-01-04 LCR Mode Option

PRG30-03-01 16:Call Forward to Station
17:Call Forward to Device
98:Message Waiting Indication Key

PRG30-05-01 Idle Extension

PRG31-03-02 Internal Paging Splash Tone

PRG35-02-19 Dialed Number Output Format 

PRG35-02-20 External CFW Information mode

PRG41-08-03 Delay Announcement Source Type

Table I-1  Conversion Exceptions

PRG No Name
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2.1 Initializing UX5000 Default Value

1. Run SV8100 PCPro.

2. Click File > New > SV8100 North America > SV8100 R4 (UX5000 
Defaults), Figure I-6 - Initial Screen.

Figure I-6  Initial Screen

3. Click the OK button that is depicted on Figure I-7 - Conversion 
Confirmation.  

The default value on the UX5000 is loaded to the SV8100 database.

PRG41-08-07 DSPDB-VM Message Box No With 
Overflow

PRG41-08-08 First Delay Announcement Source Type

PRG41-08-09 Second Delay Announcement Source 
Type

PRG45-02-02 Forced Send Dial Tone

PRG45-02-04 NSL over LAN

PRG45-03 NSL Timer Setup

PRG84-08-01 Firmware Name Setup

PRG84-11-30 Auto Gain Control

Table I-1  Conversion Exceptions

PRG No Name
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Figure I-7  Conversion Confirmation

If you click Cancel, there is no conversion and the PCPro Database  
opens as a basic SV8100 database. : 

2.2 UX5000 to SV8100 Default Differences  

    

10-20 : LAN Setup for External Equipment

Item No. Item
UX5000 
Value

SV8100 
Value

02 ACD MIS - TCP Port 0 4000

11-01 : System Numbering

1st and 2nd Dial Digits 2nd Dial Digit
Dial Type/
Dial Digit 
Length

UX5000 
Value

SV8100 
Value

1x 1-digit access code Type Service Code 
(1)

Extension 
(2)

3x 1-digit access code Dial Digit 
Length

3 4

4x 1-digit access code Type Extension (2) Service 
Code (1)

5x 1-digit access code Dial Digit 
Length

4 3

Type Extension (2) Service 
Code (1)

6x 1-digit access code Type Extension (2) Service 
Code (1)

7x 1-digit access code Type Extension (2) Service 
Code (1)

8x 1-digit access code Dial Digit 
Length
code

3 1
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11-02 : Extension Numbering

Extension Port 
Number

Item UX5000 Value SV8100 Value

1-512 Extension 301-499,5000-5312 101-199,3101-3513

11-04 : Virtual Extension Numbering

Virtual Extension Port 
Number Item UX5000 Value SV8100 Value

1-256 Virtual Extension 201-299, 3601-3757

11-10 :  Service Code Setup (for System Administrator)

Service 
Code Function

UX5000 
Value

SV8100 
Value

01 Night Mode Switching for Own Group 818 718

03 Set System Time 828 728

04 Store Common Speed Dials 853 753

05  Store Group Speed Dials 854 754

06  Set Trunk to Trunk Transfer per Trunk 833 733

07 Cancel Trunk to Trunk Transfer per Trunk 834 734

08 Set Trunk to Trunk Transfer Destination per 
Trunk

835 735

12 Night Mode Switching for Other Group 118 618

16  Leave Message Waiting 126 626
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17  Supervisor Dial Block per Extension 101 601

18 Call Forward Off-Premise by Doorphone 822 722

20 Playback/Record/Erase VRS Message 116 616

21  Playback VRS General Message 111 611

22  Record/Erase VRS General Message 112 612

23  Print SMDR per Extension 121 621

24  Print SMDR per Department Group 122 622

25  Print SMDR per Account Code 123 623

26  Forced Trunk Disconnect (Analog Trunk only) *3

27  Trunk Port Disable for Outgoing Calls 145 645

11-11 :  Service Code Setup (for Setup/Entry Operation)

Service 
Code Function

UX5000 
Value

SV8100 
Value

01 Set/Cancel Call Forward Immediate 741

02 Set/Cancel Call Forward Busy 742

03 Set/Cancel Call Forward No Answer 743

04 Set/Cancel Call Forward Busy/No Answer 744

05 Set/Cancel Call Forward Both Ring 745

07 Set/Cancel Call Forward Follow-me 746

08 Set/Cancel Do Not Disturb 847 747

10 Cancel All Messages Waiting 873 773

11-10 :  Service Code Setup (for System Administrator)

Service 
Code Function

UX5000 
Value

SV8100 
Value
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11 Cancel Message Waiting 871 771

12 Set Alarm Clock 827 727

13 Set Display Language 178 678

15 Enable Handsfree Incoming Intercom Calls 821 721

16 Enable Force Ringing of Incoming Intercom Calls 823 723

17 Set Programmable Function Keys (Normal 
Codes)

851 751

18 Enable/Disable Background Music 825 725

19 Enable/Disable Key Touch Tone 824 724

20 Set Incoming Ring Tones 820 720

21 Play Incoming Ring Tones 811 711

22 Set Extension Name 800 700

23 Enable/Disable Second Call Override 179 679

24 Set Class of Service per Extension 177 677

25 Enable Transfer All per Department Group 102 602

26 Disable Transfer All per Department Group 103 603

27  Set Transfer Destination per Department Group 104 604

28 Enable Delayed Transfer per Department Group 105 605

29 Disable Delayed Transfer per Department Group 106 606

30 Enable Do Not Disturb per Department Group 107 607

31 Disable Do Not Disturb per Department Group 108 608

33  Dial Block 100 600

34 Temporary Toll Restriction Override 875 775

35 Department Group Login/Logout 150 650

36 Walking Toll Restriction 163 663

37 Adjust Ring Volume 829 729

38 Set Programmable Function Keys (Appearance 
Codes)

852 752

39 One Touch Dial Entry 855 755

42 Wireless Transfer when Out Of Range 689

43 Enable/Disable Headset Ringing Mode Switching 188 688

52 Set/Cancel Call Forward All Calls per Extension 790

53 Set/Cancel Call Forward Busy per Extension 791

11-11 :  Service Code Setup (for Setup/Entry Operation)

Service 
Code Function

UX5000 
Value

SV8100 
Value



UNIVERGE SV8100 Issue 5.0

PC Programming Manual I - 11

___________________________________________________________________________________

___________________________________________________________________________________

  

54 Set/Cancel Call Forward No Answer per 
Extension

792

55 Set/Cancel Call Forward Busy/No Answer per 
Extension

793

58  Call Forward with VAU Personal Greeting 713

62 Adjust Headset Ring Volume 874 662

11-12 : Service Code Setup (for Service Access)

Service 
Code

Function
UX5000 
Value

SV8100 
Value

01 Call Forward/Do Not Disturb Override) 807 707

03 Override Off-hook Signaling 809 709

04 Set Camp-on 850 750

05 Cancel Camp-on 870 770

06 Voice Call & Signal Call Switching 812 712

07 Step Call 808 708

08 Barge-in 810 710

13 Saved Number Redial 815 715

14 Trunk Group Access 804 704

17 Clear Last Number Redial 876 776

18 Clear Saved Number Redial List 885 785

19 Internal Group Paging 801 701

20 External Paging 803 703

21 Meet-me Answer to Specified Internal Paging 
Group

864 764

22 Meet-me Answer to External Paging 865 765

23 Meet-me Answer in Same Paging Group 863 763

25 Direct Call Pickup for Own Group 856 756

26 Call Pickup for Specified Group 868 768

28 Call Pickup for Any Group 869 769

30 Specified Trunk Answer 172 672

33 Group Hold 832 732

11-11 :  Service Code Setup (for Setup/Entry Operation)

Service 
Code Function

UX5000 
Value

SV8100 
Value



I - 12

___________________________________________________________________________________

___________________________________________________________________________________Issue 5.0 UNIVERGE SV8100

  

34 Answer for Group Hold 862 762

35 Station Park Hold 857 757

36 Doorphone Access 802 702

37 Common Canceling Service Code 120 620

38 General Purpose Indication 883 783

41 Voice Over 890 690

44 SLT Callback Test 899 799

45 Enable SLT On-hook When Holding 849 749

46 Answer SLT On-hook When Holding 859 759

47 SLT Call Waiting Answer/Split Answer 894 794

50 General Purpose Relay 880 780

53  SLT Live Recording 154 654

54 ANI/DNIS Routing to VRS 882 782

56 E911 Alarm Shut Off 886 786

58 Transfer Into Conference 124 624

11-13 : Service Code Setup (for ACD)

Service 
Code Function

UX5000 
Value

SV8100 
Value

02  SLT ACD Logout 155 655

03 Set SLT ACD Wrap-Up Time 156 656

04 Cancel SLT ACD Wrap-Up Time 157 657

05 Set SLT ACD Off Duty 158 658

06 Cancel SLT ACD Off Duty 159 659

10 Supervisor ACD Agent Login 167 667

11 Supervisor ACD Agent Logout 168 668

12 Supervisor Change Agent ACD Group 169 669

13 Change Agent for Own ACD Group 170 670

11-12 : Service Code Setup (for Service Access)

Service 
Code

Function
UX5000 
Value

SV8100 
Value
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11-14 : Service Code Setup (for Hotel)

Service 
Code

Function
UX5000 
Value

SV8100 
Value

01 Enable Do Not Disturb for Own Extension 127 627

02 Disable Do Not Disturb for Own Extension 128 628

03 Enable Do Not Disturb for Other Extension 129 629

04 Disable Do Not Disturb for Other Extension 130 630

05 Enable Wake-up Call for Own Extension 131 631

06 Disable Wake-up Call for Own Extension 132 632

07 Enable Wake-up Call for Other Extension 133 633

08 Disable Wake-up Call for Other Extension 134 634

09 Enable Room to Room Call Restriction 135 635

10 Disable Room to Room Call Restriction 136 636

11 Change Toll Restriction Class for Other 
Extension

137 637

12 Check-in 138 638

13 Check-out 139 639

14 Change Room Status for Own Extension 140 640

15 Change Room Status for Other Extension 141 641

16 Print Room Status 142 642

17 Hotel Room Monitor 175 675

18 Set Hotel PMS Toll Restriction 166 666

11-15 : Service Code Setup, Administrative (for Special Access)

Service 
Code

Function
UX5000 
Value

SV8100 
Value

01 Remote Maintenance 830 730

02 ACD Access in DID Translation Table 860 760

08 Network Message Lamp Control 866 766

14 Modem Access  740
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11-16  : Single Digit Service Code Setup

Service 
Code

Function
UX5000 
Value

SV8100 
Value

01 Step Call # 2

04 Intercom Off-hook Signaling 7 *

05 Camp-on 2 #

14-02 :  Analog Trunk Data Setup

Trunk Item UX5000 Value SV8100 Value

1~200 02 - Incoming Call Detection Type Normal (0) Immediately ring (1)

17 - Synchronous Ringing Not Checked (0) Checked (1)

23 - Caller ID Receiving Method Wait Caller ID (0) Immediate Ring (1)

14-07 : Trunk Access Map Setup

Access 
Map

Trunk UX5000 Value SV8100 Value

2-200 1-200 No (0) INC/OTG/Hold (7)

15-01 : Basic Extension Data Setup

ICM 
Extension

Item UX5000 Value SV8100 Value

301 01 - Name STA 301~499, 
5000~5312

STA 101~199, 
3101~3513
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15-02 : Multiline Telephone Basic Data Setup

Item No. Item UX5000 Value SV8100 Value

12 Off-hook Signaling Type Muted Off-hook 
Ringing (0)

1 Beep Tone in 
Speaker and 
Handset (5)

35 Message Waiting Lamp Cycle for 
Calling Extension

Cycle 7 (1000ms 
on) (7)

Cycle 3 (125ms 
on, 125ms off) 

(3)

36 Message Waiting Lamp Cycle for 
Called Extension

Cycle 3 (125ms 
on, 125ms off) 

(3)

Cycle 2 (250ms 
on, 250ms off) 

(2)

38 Voice Mail Message Waiting 
Lamp Cycle

Cycle 3 (125ms 
on, 125ms off) 

(3)

Cycle 2 (250ms 
on, 250ms off) 

(2)

47 DESI-less Icon Display Not Checked (0) Checked (1)

15-05 : IP Telephone Terminal Basic Data Setup

Extension Item UX5000 Value SV8100 Value

301~499, 
5000~5312

01 - Terminal Type NGT (0) MEGACO (3)

15- 18 : Virtual Extension Key Enhanced Options

ICM 
Extension

Item UX5000 Value SV8100 Value

301-499, 
5000-5312

Display Mode when placing a Call 
on Virtual Extension Key

Display 
Secondary 

Extension Name 
(0)

Display Actual 
Station Name (1)

15-20 : LCD Line Key Name Assignment

Extension Function Key UX5000 Value SV8100 Value

301-499, 
5000-5312

1 LINE 1 CO 001



I - 16

___________________________________________________________________________________

___________________________________________________________________________________Issue 5.0 UNIVERGE SV8100

  

  

  

2 LINE 2 CO 002

3 LINE 3 CO 003

4 LINE 4 CO 004

5 LINE 5 CO 005

6 LINE 6 CO 006

7 LINE 7 CO 007

8 LINE 8 CO 008

20-02 : System Options for Multiline Telephones

Item No. Item UX5000 Value SV8100 Value

01 Trunk Group Key Operation Mode Keep Lamp (0) Extinction (1)

20-04 : System Options for Virtual Extensions

Item No. Item UX5000 Value SV8100 Value

04 Virtual Extension Key Seize Mode Normal (0) Enhanced (1)

20-09 : Class of Service Options (Incoming Call Service)

Class of 
Service

Item UX5000 Value SV8100 Value

1-15 01 - Second Call for DID/DISA/
DIL/E&M

Not Checked (0) Checked (1)

 07 - Call Queuing Not Checked (0) Checked (1)

15-20 : LCD Line Key Name Assignment

Extension Function Key UX5000 Value SV8100 Value
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20-10 : Class of Service Options (Answer Service)

Class of 
Service

Item UX5000 Value SV8100 Value

1-15 08 - Automatic Off-hook Answer 
for Call Coverage Keys

Not Checked (0) Checked (1)

 09 - Call Pickup for Callback Not Checked (0) Checked (1)

20-11 : Class of Service Options (Hold/Transfer Service)

Class of 
Service

Item UX5000 Value SV8100 Value

1-15 11 - Automatic On-hook Transfer Checked (1) Not Checked (0)

 23 - Set/Cancel VE/SE Call 
Forward

Not Checked (0) Checked (1)

24 - Trunk Park Hold Mode Not Checked (0) Checked (1)

25 - Park Call Transfer Restriction Not Checked (0) Checked (1)

20-13 : Class of Service Options (Supplementary Service)

Class of 
Service

Item UX5000 Value SV8100 Value

1-15 36 - Call Duration Display Not Checked (0) Checked (1)

 45 - MIC Key Mode While Call 
Monitoring

Not Checked (0) Checked (1)

47 - Station Number Display Not Checked (0) Checked (1)

20-14 : Class of Service Options for DISA/E&M

Class of 
Service

Item UX5000 Value SV8100 Value

1-15 02 - Trunk Group Routing/ARS 
Access

Not Checked (0) Checked (1)

 03 - Trunk Group Access Not Checked (0) Checked (1)

05 - Operator Calling Not Checked (0) Checked (1)



I - 18

___________________________________________________________________________________

___________________________________________________________________________________Issue 5.0 UNIVERGE SV8100

  

  

  

  

1-15 06 - Internal Paging Not Checked (0) Checked (1)

07 - External Paging Not Checked (0) Checked (1)

12 - Retrieving Park Hold Not Checked (0) Checked (1)

20-15 : Ring Cycle Setup

Item No. Incoming Signal Type UX5000 Value SV8100 Value

1 Normal Incoming Call on Trunk Cycle 8 
(0.375sec on, 
0.25sec off, 

0.375sec on, 
2sec on) (8))

Cycle 2 (2sec on, 
4sec off) (2)

20-17 : Operator Extension

Operator Operator Extension UX5000 Value SV8100 Value

1 Extension 301 101

20-22 : System Options for Wireless

Item No. Item UX5000 Value SV8100 Value

05  DECTPP Out of Range 0 8

20-25 : ISDN Options

Item No. Item UX5000 Value SV8100 Value

08 Low Layer Compatibility (LLC) Checked (1) Not Checked (0)

09 High Layer Compatibility (HLC) Checked (1) Not Checked (0)

20-14 : Class of Service Options for DISA/E&M

Class of 
Service

Item UX5000 Value SV8100 Value
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20-31 : Timer Class Timer Assignment

Time 
Class

Item UX5000 Value SV8100 Value

1 17 - VRS/DISA No Answer Time 
(Disconnect/Incoming Ring 
Group/Voice Mail)

30 0

19 - Trunk to Trunk Long 
Conversation Warning Tone Time

180 3600

20-34 : Conference Group Setup

Conference Group Setting UX5000 Value SV8100 Value

1 Name Conf 1  

 Password 1111  

 Maximum Participants 8 0

 Maximum Conference Duration 7200 0

 Ending Conference Alert Tone Time 300 0

2 Name Conf 2  

 Password 2222  

 Maximum Participants 8 0

 Maximum Conference Duration 7200 0

 Ending Conference Alert Tone Time 300 0

3 Name Conf 3  

 Password 3333  

 Maximum Participants 8 0

 Maximum Conference Duration 7200 0

 Ending Conference Alert Tone Time 300 0

4 Name Conf 4  

 Password 4444  

 Maximum Participants 8 0

 Maximum Conference Duration 7200 0

 Ending Conference Alert Tone Time 300 0
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21-01 : System Options for Outgoing Calls

Item No. System Option UX5000 Value SV8100 Value

18 Reset Dial after Trunk Access 
Failure

Enabled (0) Disabled (1)

21-22 : CO Message Waiting Indication – Call Back Settings

Trunk Item No. Item UX5000 Value SV8100 Value

1~200 1 CO Message Waiting Indication 
Callback Speed Dial Destination

0 1999

25-07 : System Timers for VRS/DISA

Item No. Item UX5000 Value SV8100 Value

02 VRS/DISA No Answer Interval 30 0

07 Long Conversation Warning Tone 180 3600

26-07 : LCR Cost Center Code Table

Extension UX5000 Value SV8100 Value

301-499, 5000-5312 301-499, 5000-5312 101-199,3101-3513

30-03 : DSS Console Key Assignment

DSS Console DSS Key Additional Data UX5000 Value SV8100 Value

1-32 1 Additional Data 301 101

2 Additional Data 302 102

3 Additional Data 303 103

4 Additional Data 304 104

5 Additional Data 305 105

6 Additional Data 306 106
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7 Additional Data 307 107

8 Additional Data 308 108

9 Additional Data 309 109

10 Additional Data 310 110

11 Additional Data 311 111

12 Additional Data 312 112

13 Additional Data 313 113

14 Additional Data 314 114

15 Additional Data 315 115

16 Additional Data 316 116

17 Additional Data 317 117

18 Additional Data 318 118

19 Additional Data 319 119

20 Additional Data 320 120

21 Additional Data 321 121

22 Additional Data 322 122

23 Additional Data 323 123

24 Additional Data 324 124

25 Additional Data 325 125

26 Additional Data 326 126

27 Additional Data 327 127

28 Additional Data 328 128

29 Additional Data 329 129

30 Additional Data 330 130

31 Additional Data 331 131

32 Additional Data 332 132

33 Additional Data 333 133

34 Additional Data 334 134

35 Additional Data 335 135

36 Additional Data 336 136

37 Additional Data 337 137

38 Additional Data 338 138

39 Additional Data 339 139

30-03 : DSS Console Key Assignment

DSS Console DSS Key Additional Data UX5000 Value SV8100 Value
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40 Additional Data 340 140

41 Additional Data 341 141

42 Additional Data 342 142

43 Additional Data 343 143

44 Additional Data 344 144

45 Additional Data 345 145

46 Additional Data 346 146

47 Additional Data 347 147

48 Additional Data 348 148

49 Additional Data 349 149

50 Additional Data 350 150

51 Additional Data 351 151

52 Additional Data 352 152

53 Additional Data 353 153

54 Additional Data 354 154

55 Additional Data 355 155

56 Additional Data 356 156

57 Additional Data 357 157

58 Additional Data 358 158

59 Additional Data 359 159

60 Additional Data 360 160

30-05 : DSS Console Lamp Table

Item No. Item UX5000 Value SV8100 Value

21 - Voice 
Mail 

Message 
Indication

Lamp Pattern Pattern 6 (625ms 
on, 125ms off, 

125ms on, 
125ms off) (6)

Pattern 3 (125ms 
on, 125ms off) (3)

30-03 : DSS Console Key Assignment

DSS Console DSS Key Additional Data UX5000 Value SV8100 Value
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40-10 : Voice Announcement Service Option

Item No. Item UX5000 Value SV8100 Value

01 VRS Fixed Messaging Checked (1) Not Checked (0)

45-01 : Voice Mail Integration Options

Item No. Option UX5000 Value SV8100 Value

03 Voice Mail Call Screening Checked (1) Not Checked (0)

45-03 : NSL Timer Setup

Item No. Item UX5000 Value SV8100 Value

01 Retry Time 4 0

02 Polling Interval 20 0

03 1LS (Link Start Message) Interval 20 0

04 Wait for 1LS Time 30 0

05 Wait for 2ET Time 60 0

06 Restart LVP Check Interval 30 0

07 Wait for 1LR Time 20 0

47-01 : InMail System Options

Item No. Item UX5000 Value SV8100 Value

02 InMail Master Name IntraMail ## InMail ##

14 Maximum Attempts 5 99

47-02 : InMail Station Mailbox Options

Mailbox Item UX5000 Value SV8100 Value

1 02 - Mailbox Extension 301 101
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1 02 - Mailbox Extension 301 101

19 - Telephone User Interface 
Type

Mnemonic (1) Numeric (0)

2-64 02 - Mailbox Extension 302-364 102-164

 19 - Telephone User Interface 
Type

Mnemonic (1) Numeric (0)

65-512 19 - Telephone User Interface 
Type

Mnemonic (1) Numeric (0)

47-06 : Group Mailbox Subscriber Options

Group 
Mailbox 

Item UX5000 Value SV8100 Value

1-32 17 - Telephone User Interface 
Type

Mnemonic (1) Numeric (0)

47-07 :  InMail Routing Mailbox Options

Routing  
Mailbox 

Item UX5000 Value SV8100 Value

1-32 Telephone User Interface Type Mnemonic (1) Numeric (0)

47-10 : InMail Trunk Options

Trunk Item UX5000 Value SV8100 Value

1-200 Telephone User Interface Type Mnemonic (1) Numeric (0)

47-02 : InMail Station Mailbox Options

Mailbox Item UX5000 Value SV8100 Value
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47-13 : InMail Dial Action Table

Dial Action Table Dial Digit Item UX5000 Value SV8100 Value

1 1 Action Undefined (0) Unscreened 
Transfer (2)

  Destination  XXX

 3 Destination XXX XXXX

 4 Action Unscreened Transfer (2) Undefined (0)

  Destination XXX  

 0 Destination 301 101

 Timeout Destination 301 101

50-02 : Connecting System Settings 

CCIS 
Route ID 

Item UX5000 Value SV8100 Value

01-09 Common Signaling Channel Data 
Speed

64kbps (0) 56kbps (1)

Calling Name Indication Not Checked (0) Checked (1)

50-03 : CCIS Destination System Settings 

CCIS 
System  

ID 
Item UX5000 Value SV8100 Value

001-255 Point Code Availability Not Checked (0) Checked (1)
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50-05 : CCIS Maximum Call Forwarding Hop Counter  

Item No. Item UX5000 Value SV8100 Value

01  Maximum Hop Count 0 5

50-06 : CCIS Feature Availability 

Item No. Item
UX5000 
Value

SV8100 
Value

01 Link Reconnect Not Checked 
(0)

Checked 
(1)

02 Centralized Day/Night Switching (for Message 
Receiver Side)

Not Checked 
(0)

Checked 
(1)

50-12 : CCIS Centralized Day/Night Mode to System Mode Assignment 

Item No. Item
UX5000 
Value

SV8100 
Value

01 Day Mode 0 1

02 Night Mode 0 2

50-13 : CCIS Centralized Response Timeout Assignment

Item No. Item
UX5000 
Value

SV8100 
Value

01 IAI Response Time 0 30

50-15 : CCIS over IP Basic Information Setting

Item No. Item
UX5000 
Value

SV8100 
Value

02 Server TCP Port 0 57000

03 Client TCP Port 0 59000
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04 Connection Method for DT700 Not Checked 
(0)

Checked 
(1)

80-01-02 : Service Tone Setup

Service Tone Unit Item UX5000 Value SV8100 Value

DID Error 2 Basic Tone Tone 10 (440/
480Hz, -13/-13dB) 

(10)

Tone 11 (480/
620Hz, -13/-13dB) 

(11)

81-07 : CODEC Filter Setup for Analog Trunk Port

Trunk Item UX5000 Value SV8100 Value

1-200 Codec Filter Type Type 1 (1) Type 2 (2)

82-11 : LCA Initial Data Setup

Item No. Item
UX5000 
Value

SV8100 Value

01 Bounce Protect Time 0.0ms (0) 300.0ms (3)

02 Hookflash Start Time 40.0ms (0) 290.0ms (5)

03 Hookflash End Time HST+0ms (0) HST+700ms (7)

82-12 : OPX Initial Data Setup

Item No. Item
UX5000 
Value

SV8100 Value

01 Bounce Protect Time 0.0ms (0) 300.0ms (3)

02 Hookflash Start Time 40.0ms (0) 290.0ms (5)

50-15 : CCIS over IP Basic Information Setting

Item No. Item
UX5000 
Value

SV8100 
Value
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03 Hookflash End Time HST+0ms (0) HST+700ms (7)

84-11 : Dterm ® IP CODEC Information Basic Setup

UX5000 Value SV8100 Value

Type 1-5 26 - TX Gain 0.0dBm (20) -6.0dBm (14)

 27 - RX Gain 0.0dBm (20) -6.0dBm (14)

 32 - RTP Filter Not Checked (0) Checked (1)

84-21 : CCIS over IP CODEC Information Basic Setup

Item No. Item
UX5000 
Value

SV8100 Value

01 G.711 Maximum Audio Frame Size (0) 30ms (3)

02 G.711 Type A-law (0) u-law (1)

04 G.711 Minimum Jitter Buffer Size 0 30

05 G.711 Average Jitter Buffer Size 0 60

06 G.711 Maximum Jitter Buffer Size 0 120

07 G.729 Maximum Audio Frame Size (0) 30ms (3)

09 G.729 Minimum Jitter Buffer Size 0 30

10 G.729 Average Jitter Buffer Size 0 60

11 G.729 Maximum Jitter Buffer Size 0 120

17 TX Gain -20.0dBm (0) 0.0dBm (20)

18 RX Gain -20.0dBm (0) 0.0dBm (20)

20 Audio Capability 2nd Priority G.711_PT (0) (1)

22 Jitter Buffer Mode (0) Adaptive 
immediately (3)

23 Voice Activity Detection Threshhold -19.0dBm (0) 0.3dBm (20)

82-12 : OPX Initial Data Setup

Item No. Item
UX5000 
Value

SV8100 Value
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24 Echo Canceller Mode Not Checked 
(0)

Checked (1)

25 Echo Canceller Non-linear Processing 
Mode

Not Checked 
(0)

Checked (1)

26 UDP Checksum Mode Not Checked 
(0)

Checked (1)

27 G.722 Maximum Audio Frame Size (0) 30ms (3)

29 G.722 Minimum Jitter Buffer Size 0 30

30 G.722 Average Jitter Buffer Size 0 60

31 G.722 Maximum Jitter Buffer Size 0 120

32 G.726 Maximum Audio Frame Size (0) 30ms (3)

34 G.726 Minimum Jitter Buffer Size 0 30

35 G.726 Average Jitter Buffer Size 018 60

36 G.726 Maximum Jitter Buffer Size 0 120

37 iLBC Maximum Audio Frame Size (0) 30ms (3)

39 iLBC Minimum Jitter Buffer Size 0 30

40 iLBC Average Jitter Buffer Size 0 60

41 iLBC Maximum Jitter Buffer Size 0 120

84-30 : PVA-CCIS over IP CODEC Setup

Item No. Item
UX5000 
Value

SV8100 Value

01 G.711 Maximum Audio Frame Size (0) 30ms (2)

02 G.711 Type A-law (0) u-law (1)

04 G.711 Minimum Jitter Buffer Size 0 30

05 G.711 Average Jitter Buffer Size 0 60

06 G.711 Maximum Jitter Buffer Size 0 120

07 G.729 Maximum Audio Frame Size (0) 30ms (2)

09 G.729 Minimum Jitter Buffer Size 0 30

10 G.729 Average Jitter Buffer Size 0 60

11 G.729 Maximum Jitter Buffer Size 0 120

12 G.723 Maximum Audio Frame Size (0) 30ms (1)

84-21 : CCIS over IP CODEC Information Basic Setup

Item No. Item
UX5000 
Value

SV8100 Value
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14 G.723 Minimum Jitter Buffer Size 0 30

15 G.723 Average Jitter Buffer Size 0 60

16 G.723 Maximum Jitter Buffer Size 0 120

17 TX Gain -20.0dBm (0) 0.0dBm (20)

18 18 - RX Gain -20.0dBm (0) 0.0dBm (20)

20 20 - Audio Capability 2nd Priority G.711_PT (0) G.723_PT (1)

22 22 - Jitter Buffer Mode (0) Adaptive 
immediately (3)

23 23 - Voice Activity Detection Threshhold -19.0dBm (0) 0.3dBm (20)

24 24 - Echo Canceller Mode Not Checked 
(0)

Checked (1)

25 25 - Echo Canceller Non-linear 
Processing Mode

Not Checked 
(0)

Checked (1)

26 26 - UDP Checksum Mode Not Checked 
(0)

Checked (1)

90-02 : Programming Password Setup

Account Item UX5000 Value SV8100 Value

2 User Name UX5000 tech

90-10 : System Alarm Setup

Alarm Item UX5000 Value SV8100 Value

100 Alarm Type Not set (0) Major (1)

90-26 : Program Access Level Setup

PRG Item UX5000 Value SV8100 Value

10-31 User Level SA (System Administrator A) (3) IN (Installer) (2)

84-30 : PVA-CCIS over IP CODEC Setup

Item No. Item
UX5000 
Value

SV8100 Value
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80-02 User Level IN (Installer) (2) MAN (Manufacturer) (1)

80-03 User Level IN (Installer) (2) MAN (Manufacturer) (1)

80-04 User Level IN (Installer) (2) MAN (Manufacturer) (1)

80-05 User Level IN (Installer) (2) MAN (Manufacturer) (1)

81-01 User Level IN (Installer) (2) MAN (Manufacturer) (1)

81-02 User Level IN (Installer) (2) MAN (Manufacturer) (1)

81-04 User Level IN (Installer) (2) MAN (Manufacturer) (1)

81-05 User Level IN (Installer) (2) MAN (Manufacturer) (1)

82-01 User Level IN (Installer) (2) MAN (Manufacturer) (1)

82-03 User Level IN (Installer) (2) MAN (Manufacturer) (1)

82-04 User Level IN (Installer) (2) MAN (Manufacturer) (1)

82-05 User Level IN (Installer) (2) MAN (Manufacturer) (1)

82-08 User Level IN (Installer) (2) MAN (Manufacturer) (1)

83-11 User Level IN (Installer) (2) MAN (Manufacturer) (1)

84-04 User Level MAN (Manufacturer) (1) IN (Installer) (2)

90-31 : DIM Access over Ethernet

Item No. Item UX5000 Value SV8100 Value

02 User Name ASPIRE SV8100

90-26 : Program Access Level Setup

PRG Item UX5000 Value SV8100 Value
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Appendix J DIM File Download

SECTION 1 OVERVIEW

The DIM File Download feature supports downloading a DIM log file using PCPro. A 
DIM log file contains operational, system information, and critical information about 
the system.

 Version 4000 System Software and PC Pro 4.0 or higher is required.

SECTION 2 OPERATION

Use the following procedure to download a DIM log file using PCPro.

1. From the PCPro toolbar, select Communications > Maintenance > 
DIM File Download.  A DIM File Download dialog box appears, Figure 
J-2 - DIM File Download Dialog Box. 

 The DIM File Download menu is only available when PCPro is connected to the system.

Figure J-1  DIM File Download
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When the Download Dialogue runs, PCPro requests file information from 
"C:\\DATA\\*.txt"".  The Dialog Box displays all existing files with  
"C:\\DATA\\*.txt"".  .

Figure J-2  DIM File Download Dialog Box

2. Check the Download box next to the file(s) to download from the 
system.

3. Click OK.  PCPro begins downloading the selected file(s) from the 
system.  A status line on the bottom indicates which file is being 
downloaded at that moment.  Refer to Figure J-3 - DIM File Download 
Status.
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Figure J-3  DIM File Download Status

 Limitation: "The maximum file size that it is available to download with PCPro is 1MB 
per file.  If the file is 1.5MB the first 1MB will download fine but the last 500 KB will not 
download.
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Appendix K New IPK/IPKII Migration Support 
for PCPro

SECTION 1 OVERVIEW

With R4000 PCPro, individual cabinets can be selected to support IPK/IPKII 
packages; they must however conform to one of the supported patterns listed in the 
SV8100 Hardware Manual.

Figure K-1  PCPro Blade Configuration Screen
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Once a cabinet is selected for IPK/IPKII package support and has a slot populated, if 
the cabinet is to be changed back to SV8100 package support, the following message 
will appear.

If using Version 3000 or lower System Software, the cabinet can only be configured 
as shown below.  

In this case, when selecting the IPKII Migration check box on the 1st cabinet, PCPro 
automatically assigns cabinets 2~4 as IPK/IPKII package support.

PCPro also will not allow a user to upload a database configuration that is not 
supported by the current software.

Figure K-2  Blade Removal Screen

Figure K-3  Version 3000 System Software Cabinet Configuration
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If changing from Version 3000 System support to Version 4000 System support, and 
the “Change” button is selected, PCPro will ask the following.

This enables the combination cabinet selection view for Version 4000 System 
support, if change is selected again, PCPro will ask the following.  

This enables the Fixed (Version 3000 or lower) cabinet selection view.

Figure K-4  Combination Cabinet Selection Screen

Figure K-5  Fixed Cabinet Selection Screen
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